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Oracle, JD Edwards, PeopleSoft, and Retek are registered trademarks of Oracle Corporation and/or its affiliates.
Other namesmay be trademarks of their respective owners.
Open Source Disclosure
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About This PeopleBook Preface

PeopleBooks provide you with the information that you need to implement and use PeopleSoft applications.

This preface discusses:

• PeopleSoft application prerequisites.
• PeopleSoft application fundamentals.
• Documentation updates and printed documentation.
• Additional resources.
• Typographical conventions and visual cues.
• Comments and suggestions.
• Common elements in PeopleBooks.

Note. PeopleBooks document only page elements, such as fields and check boxes, that require additional
explanation. If a page element is not documented with the process or task in which it is used, then either
it requires no additional explanation or it is documented with common elements for the section, chapter,
PeopleBook, or product line. Elements that are common to all PeopleSoft applications are defined in this
preface.

PeopleSoft Application Prerequisites
To benefit fully from the information that is covered in these books, you should have a basic understanding
of how to use PeopleSoft applications.

You might also want to complete at least one PeopleSoft introductory training course, if applicable.

You should be familiar with navigating the system and adding, updating, and deleting information by using
PeopleSoft menus, and pages, forms, or windows. You should also be comfortable using the World Wide Web
and the Microsoft Windows or Windows NT graphical user interface.

These books do not review navigation and other basics. They present the information that you need to use the
system and implement your PeopleSoft applications most effectively.

PeopleSoft Application Fundamentals
Each application PeopleBook provides implementation and processing information for your PeopleSoft
applications.

Note. Application fundamentals PeopleBooks are not applicable to the PeopleTools product.
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For some applications, additional, essential information describing the setup and design of your system appears
in a companion volume of documentation called the application fundamentals PeopleBook. Most PeopleSoft
product lines have a version of the application fundamentals PeopleBook. The preface of each PeopleBook
identifies the application fundamentals PeopleBooks that are associated with that PeopleBook.

The application fundamentals PeopleBook consists of important topics that apply to many or all PeopleSoft
applications across one or more product lines. Whether you are implementing a single application, some
combination of applications within the product line, or the entire product line, you should be familiar with
the contents of the appropriate application fundamentals PeopleBooks. They provide the starting points
for fundamental implementation tasks.

Documentation Updates and Printed Documentation
This section discusses how to:

• Obtain documentation updates.
• Order printed documentation.

Obtaining Documentation Updates
You can find updates and additional documentation for this release, as well as previous releases, on the
PeopleSoft Customer Connection website. Through the Documentation section of PeopleSoft Customer
Connection, you can download files to add to your PeopleBook Library. You’ll find a variety of useful and
timely materials, including updates to the full PeopleSoft documentation that is delivered on your PeopleBooks
CD-ROM.

Important! Before you upgrade, you must check PeopleSoft Customer Connection for updates to the upgrade
instructions. PeopleSoft continually posts updates as the upgrade process is refined.

See Also
PeopleSoft Customer Connection, https://www.peoplesoft.com/corp/en/login.jsp

Ordering Printed Documentation
You can order printed, bound volumes of the complete PeopleSoft documentation that is delivered on your
PeopleBooks CD-ROM. PeopleSoft makes printed documentation available for each major release shortly
after the software is shipped. Customers and partners can order printed PeopleSoft documentation by using
any of these methods:

• Web
• Telephone
• Email

Web
From the Documentation section of the PeopleSoft Customer Connection website, access the PeopleBooks
Press website under the Ordering PeopleBooks topic. The PeopleBooks Press website is a joint venture
between PeopleSoft and MMA Partners, the book print vendor. Use a credit card, money order, cashier’s
check, or purchase order to place your order.
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Telephone
Contact MMA Partners at 877 588 2525.

Email
Send email to MMA Partners at peoplebookspress@mmapartner.com.

See Also
PeopleSoft Customer Connection, https://www.peoplesoft.com/corp/en/login.jsp

Additional Resources
The following resources are located on the PeopleSoft Customer Connection website:

Resource Navigation

Application maintenance information Updates + Fixes

Business process diagrams Support, Documentation, Business Process Maps

Interactive Services Repository Interactive Services Repository

Hardware and software requirements Implement, Optimize + Upgrade, Implementation Guide,
Implementation Documentation & Software, Hardware and
Software Requirements

Installation guides Implement, Optimize + Upgrade, Implementation Guide,
Implementation Documentation & Software, Installation
Guides and Notes

Integration information Implement, Optimize + Upgrade, Implementation Guide,
Implementation Documentation and Software, Pre-built
Integrations for PeopleSoft Enterprise and PeopleSoft
EnterpriseOne Applications

Minimum technical requirements (MTRs) (EnterpriseOne
only)

Implement, Optimize + Upgrade, Implementation Guide,
Supported Platforms

PeopleBook documentation updates Support, Documentation, Documentation Updates

PeopleSoft support policy Support, Support Policy

Prerelease notes Support, Documentation, Documentation Updates,
Category, Prerelease Notes

Product release roadmap Support, Roadmaps + Schedules

Release notes Support, Documentation, Documentation Updates,
Category, Release Notes
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Resource Navigation

Release value proposition Support, Documentation, Documentation Updates,
Category, Release Value Proposition

Statement of direction Support, Documentation, Documentation Updates,
Category, Statement of Direction

Troubleshooting information Support, Troubleshooting

Upgrade documentation Support, Documentation, Upgrade Documentation and
Scripts

Typographical Conventions and Visual Cues
This section discusses:

• Typographical conventions.
• Visual cues.
• Country, region, and industry identifiers.
• Currency codes.

Typographical Conventions
This table contains the typographical conventions that are used in PeopleBooks:

Typographical Convention or Visual Cue Description

Bold Indicates PeopleCode function names, business function
names, event names, system function names, method
names, language constructs, and PeopleCode reserved
words that must be included literally in the function call.

Italics Indicates field values, emphasis, and PeopleSoft or other
book-length publication titles. In PeopleCode syntax,
italic items are placeholders for arguments that your
program must supply.

We also use italics when we refer to words as words or
letters as letters, as in the following: Enter the letterO.

KEY+KEY Indicates a key combination action. For example, a plus
sign (+) between keys means that you must hold down
the first key while you press the second key. For ALT+W,
hold down the ALT key while you press the W key.

Monospace font Indicates a PeopleCode program or other code example.
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Typographical Convention or Visual Cue Description

“ ” (quotation marks) Indicate chapter titles in cross-references and words that
are used differently from their intended meanings.

. . . (ellipses) Indicate that the preceding item or series can be repeated
any number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode
syntax. Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

Visual Cues
PeopleBooks contain the following visual cues.

Notes
Notes indicate information that you should pay particular attention to as you work with the PeopleSoft system.

Note. Example of a note.

If the note is preceded by Important!, the note is crucial and includes information that concerns what you must
do for the system to function properly.

Important! Example of an important note.

Warnings
Warnings indicate crucial configuration considerations. Pay close attention to warning messages.

Warning! Example of a warning.

Cross-References
PeopleBooks provide cross-references either under the heading “See Also” or on a separate line preceded by
the word See. Cross-references lead to other documentation that is pertinent to the immediately preceding
documentation.
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Country, Region, and Industry Identifiers
Information that applies only to a specific country, region, or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a country-specific heading: “(FRA) Hiring an Employee”

Example of a region-specific heading: “(Latin America) Setting Up Depreciation”

Country Identifiers
Countries are identified with the International Organization for Standardization (ISO) country code.

Region Identifiers
Regions are identified by the region name. The following region identifiers may appear in PeopleBooks:

• Asia Pacific
• Europe
• Latin America
• North America

Industry Identifiers
Industries are identified by the industry name or by an abbreviation for that industry. The following industry
identifiers may appear in PeopleBooks:

• USF (U.S. Federal)
• E&G (Education and Government)

Currency Codes
Monetary amounts are identified by the ISO currency code.

Comments and Suggestions
Your comments are important to us. We encourage you to tell us what you like, or what you would like to
see changed about PeopleBooks and other PeopleSoft reference and training materials. Please send your
suggestions to:

PeopleSoft Product Documentation Manager PeopleSoft, Inc. 4460 Hacienda Drive Pleasanton, CA 94588

Or send email comments to doc@peoplesoft.com.

While we cannot guarantee to answer every email message, we will pay careful attention to your comments
and suggestions.
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Common Elements Used in PeopleBooks
Address Book Number Enter a unique number that identifies the master record for the entity. An

address book number can be the identifier for a customer, supplier, company,
employee, applicant, participant, tenant, location, and so on. Depending on the
application, the field on the form might refer to the address book number as
the customer number, supplier number, or company number, employee or
applicant id, participant number, and so on.

As If Currency Code Enter the three-character code to specify the currency that you want to use
to view transaction amounts. This code allows you to view the transaction
amounts as if they were entered in the specified currency rather than the
foreign or domestic currency that was used when the transaction was originally
entered.

Batch Number Displays a number that identifies a group of transactions to be processed by
the system. On entry forms, you can assign the batch number or the system
can assign it through the Next Numbers program (P0002).

Batch Date Enter the date in which a batch is created. If you leave this field blank, the
system supplies the system date as the batch date.

Batch Status Displays a code from user-defined code (UDC) table 98/IC that indicates the
posting status of a batch. Values are:
Blank: Batch is unposted and pending approval.
A: The batch is approved for posting, has no errors and is in balance, but it
has not yet been posted.
D: The batch posted successfully.
E: The batch is in error. You must correct the batch before it can post.
P: The system is in the process of posting the batch. The batch is unavailable
until the posting process is complete. If errors occur during the post, the
batch status changes to E.
U: The batch is temporarily unavailable because someone is working with
it, or the batch appears to be in use because a power failure occurred while
the batch was open.

Branch/Plant Enter a code that identifies a separate entity as a warehouse location, job,
project, work center, branch, or plant in which distribution and manufacturing
activities occur. In some systems, this is called a business unit.

Business Unit Enter the alphanumeric code that identifies a separate entity within a
business for which you want to track costs. In some systems, this is called a
branch/plant.

Category Code Enter the code that represents a specific category code. Category codes are
user-defined codes that you customize to handle the tracking and reporting
requirements of your organization.

Company Enter a code that identifies a specific organization, fund, or other reporting
entity. The company code must already exist in the F0010 table and must
identify a reporting entity that has a complete balance sheet.
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Currency Code Enter the three-character code that represents the currency of the transaction.
PeopleSoft EnterpriseOne provides currency codes that are recognized by
the International Organization for Standardization (ISO). The system stores
currency codes in the F0013 table.

Document Company Enter the company number associated with the document. This number, used
in conjunction with the document number, document type, and general ledger
date, uniquely identifies an original document.
If you assign next numbers by company and fiscal year, the system uses the
document company to retrieve the correct next number for that company.
If two or more original documents have the same document number and
document type, you can use the document company to display the document
that you want.

Document Number Displays a number that identifies the original document, which can be a
voucher, invoice, journal entry, or time sheet, and so on. On entry forms, you
can assign the original document number or the system can assign it through
the Next Numbers program.

Document Type Enter the two-character UDC, from UDC table 00/DT, that identifies the origin
and purpose of the transaction, such as a voucher, invoice, journal entry,
or time sheet. PeopleSoft EnterpriseOne reserves these prefixes for the
document types indicated:
P: Accounts payable documents.
R: Accounts receivable documents.
T: Time and pay documents.
I: Inventory documents.
O: Purchase order documents.
S: Sales order documents.

Effective Date Enter the date on which an address, item, transaction, or record becomes
active. The meaning of this field differs, depending on the program. For
example, the effective date can represent any of these dates:

• The date on which a change of address becomes effective.
• The date on which a lease becomes effective.
• The date on which a price becomes effective.
• The date on which the currency exchange rate becomes effective.
• The date on which a tax rate becomes effective.

Fiscal Period and Fiscal
Year

Enter a number that identifies the general ledger period and year. For many
programs, you can leave these fields blank to use the current fiscal period and
year defined in the Company Names & Number program (P0010).

G/L Date (general ledger
date)

Enter the date that identifies the financial period to which a transaction will be
posted. The system compares the date that you enter on the transaction to the
fiscal date pattern assigned to the company to retrieve the appropriate fiscal
period number and year, as well as to perform date validations.
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PeopleSoft EnterpriseOne Tools Translation
Tools Preface

This preface discusses Object Management Workbench companion documentation.

PeopleSoft EnterpriseOne Tools Overview
Additional, essential information describing the setup and design of PeopleSoft EnterpriseOne Tools resides
in companion documentation. The companion documentation consists of important topics that apply to
Translation Tools as well as other PeopleSoft EnterpriseOne Tools. You should be familiar with the contents of
these companion PeopleBooks:

• Development Guidelines for Application Design
• Development Tools: Data Dictionary
• Development Tools: Form Design Aid
• Development Tools: Report Design Aid

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Guidelines for Application Design, “Getting
Started with PeopleSoft EnterpriseOne Tools Development Guidelines for Application Design”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Data Dictionary, “Getting Started
with PeopleSoft EnterpriseOne Tools Development Tools: Data Dictionary”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Form Design Aid, “Getting Started
with PeopleSoft EnterpriseOne Tools Development Tools: Form Design Aid”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Report Design Aid, “Getting Started
with PeopleSoft EnterpriseOne Tools Development Tools: Report Design Aid”
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CHAPTER 1

Getting Started with PeopleSoft EnterpriseOne
Tools Translation Tools

This chapter discusses:

• Translation Tools Overview

• Translation Tools Implementation

Translation Tools Overview
Translation Tools are tools that translate PeopleSoft software products from a source language, such as English,
into multiple target languages quickly and efficiently.

Translation Tools Implementation
This section provides an overview of the steps that are required to implement Translation Tools.

In the planning phase of the implementation, take advantage of all PeopleSoft sources of information,
including the installation guides and troubleshooting information. A complete list of these resources appears in
the preface in About These PeopleBooks with information about where to find the most current version of each.

Translation Tools Implementation Steps
This table lists the steps for the Translation Tools implementation.

Step Reference

1. Install EnterpriseOne. EnterpriseOne installation documentation for your
platform.

2. Install one or more EnterpriseOne applications. EnterpriseOne installation documentation for your
applications.
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CHAPTER 2

Understanding PeopleSoft Software

This chapter provides an overview of the PeopleSoft EnterpriseOne product lines and systems and discusses
how to:

• Become familiar with the appropriate PeopleSoft documentation.
• Use system codes to identify product lines for translation.

PeopleSoft Software
This section lists a prerequisite and discusses PeopleSoft translation tools.

Prerequisite
Before you begin translating PeopleSoft software, you should familiarize the self with appropriate
documentation.

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Guidelines for Application Design,
“Understanding Application Development Guidelines”

PeopleSoft Translation Tools
PeopleSoft software supports manufacturing, financials, distribution and logistics, and human resource
operations for multisite and multinational organizations. An organization’s business needs determine what
product lines are installed in its enterprise system. Complex business situations might require several product
lines to achieve a comprehensive solution. The PeopleSoft System combines those applications with an
integrated toolset and tailors them to meet the needs of each business.

Product lines are created from combinations of systems. For example, the PeopleSoft EnterpriseOne Financial
Management product line includes system 03B (Accounts Receivable), system 04 (Accounts Payable), system
09 (General Accounting), system 12 (Fixed Assets), and other systems. Systems, in turn, consist of executable
functions, forms, reports, database tables, and other components that are designed for specific business needs.

You use PeopleSoft Translation Tools to translate each component of each system in PeopleSoft software.
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CHAPTER 3

Using PeopleSoft Translation Tools

This chapter provides overviews of translation tools and the translation tools interface and discusses how to:

• Access the PeopleSoft Translation Tools.
• Review audit information for a Delta Process.
• Set PeopleSoft Translation Tools options.
• Check the spelling of translations.
• Change item status.
• Enter translations manually.
• Copy translations.
• Use suggestions.
• Use source and target preview.
• Use keyboard shortcuts.
• Search and replace text.
• Approve target items.
• Save translations.

Understanding Translation Tools
This section discusses:

• Translation tools fundamentals.
• Consistency features.
• Suggestions.
• Space constraints.
• Translating controls.
• Search and replace.
• Spell check.
• Default codes.
• Translatable PeopleSoft items.
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Translation Tools Fundamentals
PeopleSoft Translation Tools provide these features:

• Contextual references.
As you translate the interface, you can view items in context.

• Consistency features.
You can view previously translated terms to ensure a consistent translation.

• Automated translations.
When you select an item to translate, the PeopleSoft Translation Tools searches the database for that item. If
it finds a match, Translation Tools automatically displays the translation.

In most translation applications, items appear in context. For example, all items within a task appear together,
and the items of a form are displayed the way that they appear in the software so that you can view the
context while translating.

During the translation cycle for a new release of PeopleSoft software, the items to be translated are made
available to the translators through the Delta Process. The Delta Process extracts the translatable items from
the software, stores these items in a PeopleSoft-supported database, and assigns status codes to the items.

When extracting the translatable items from the software, the Delta Process compares the new release of
PeopleSoft software with the previous release to locate the changes, and assigns a status of 20 (Untranslated)
to new or changed items.

As you translate using PeopleSoft Translation Tools, you update items on a PeopleSoft-supported database
every time that you click OK.

Important! The system has no lock capability, and two or more translators can access and translate the same
item at the same time. The last translation saved is the translation that is reflected in the system. If two or
more translators are working on the same system, they should divide their work to ensure that they do not
overwrite each other’s work.

PeopleSoft software contains a variety of product lines that relate to different departments within an
organization, such as distribution, manufacturing, and human resources. Multiple systems reside within
each product line.

You might be assigned to translate the human resources and financial verticals. As you translate different
systems, you will notice that, due to the subject of the applications, terms used in one system are not used in
others.

Although you can translate the software items in any order, you should translate the software interface in
this order:

1. Glossary entries (using a translation memory such as TRADOS).
2. Data dictionary items.
3. Processing options.
4. Forms.
5. Reports.
6. Menus.
7. Tasks.
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8. User defined codes.
9. Resource files.
10. Miscellaneous items.

Consistency Features
PeopleSoft Translation Tools provide features that enable you to translate consistently. Because a single term
can have multiple meanings, you should translate source terms consistently throughout a system. You use
consistency features to ensure that previously translated terms are consistent with current translations.

Suggestions
When you select a previously translated item, PeopleSoft Translation Tools enters the selected translations in
the Source and Target translation fields. You can set up PeopleSoft Translation Tools to suggest the previous
translation or to always suggest the data dictionary description, even when the item has an override.

The suggestions for previous translations come from the source language database. PeopleSoft Translation
Tools enables you to add new suggestions as well as edit existing ones.

Space Constraints
A fixed amount of space is available for each translatable item. Because translated information requires
varying lengths of text, you might have to abbreviate the translations. When you have exceeded the number of
bytes allotted for an item, the system generates one of these warnings:

• Abbreviate the translation.
• Use another term.
• Check the preview. (Many forms have maximum and minimum buttons that enable the user to control the
length of the controls.)

Translating Controls
The amount of space that is available for the translation is measured either in characters or pixels, depending
on the type of control that is chosen. This table contains the nine types of controls that are available and
whether the control uses a pixel- or character-based measurement:

Control Space Measurement

Push Button Pixel-based

Check Box Pixel-based

Radio Button Pixel-based

Static Text Pixel-based

Group Box Pixel-based

Hyper Button Character-based

Bitmap Character-based
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Control Space Measurement

Text Variable Character-based

Control Pixel-based

Search and Replace
Each PeopleSoft translation application except FASTR, Favorites, and Menus includes a search-and-replace
feature. Each tool has slightly different search-and-replace functionality and, depending on the type of text,
requires separate search criteria. You access the search-and-replace feature from each tool separately. For
example, you cannot perform a search of user-defined code (UDC) items and replace them using the F79750:
Forms Design Aid (FDA) tool.

Spell Check
You can use the Microsoft Word spell check feature with most PeopleSoft Translation Tools. Before using
spell check in PeopleSoft Translation Tools, you must select the appropriate language options in Microsoft
Word. You can use spell check only for single-byte languages. You should use the spell check feature before
you save translations.

Default Codes
Within PeopleSoft Translation Tools, all translatable items must have a status code. Status codes indicate:

• The status of each translatable item.
• Whether the item is ready to be packaged in the software.
• The location of the item in the translation process.

As you translate, you enter the appropriate status codes to ensure that the source terms do not appear in
the software. During the software mastering process, only translated items with these statuses appear in
the software:

• Complete (status = 11).
• FDA/RDA DD Default (status = 15).
• Review (status = 25).

If a translated item has any other status codes assigned, the source term for that translated item appears
in the software.

In addition to the status codes, two other types of codes further define the translatable item:

• Reason
• Skip

The Delta Process updates the Reason code to indicate the type of change (for example, a text or size change).
You update the Skip code to indicate why you did not translate the item (for example, the item is test data or
a translation is not needed for the language). If you assign a Skip code to an item, the Source text appears
in the software.
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Translatable PeopleSoft Items
The translatable items in PeopleSoft software include:

• Data dictionary items
• Glossary entries
• Processing options
• Forms
• Reports
• Tasks
• User-defined codes
• Resource files
• Miscellaneous items

You can use PeopleSoft Translation Tools to translate all items. However, you can use a translation memory,
such as TRADOS, to translate glossary items for processing options and data items.

Data Dictionary Items
The data dictionary stores the text items that are used for row and column headings, alpha descriptions, and
glossaries (F1 or field-level helps) for reuse. When translating these text items, you should view the associated
glossary entry, if available, to understand the context of the data dictionary item and to ensure that you are
using consistent translations.

Glossary Entries
Glossary entries describe data dictionary items and their use in the software. You can view glossaries from
multiple applications by using PeopleSoft Translation Tools. Being able to view the glossaries from multiple
applications enables you to see their context while you translate. You translate each entry using a translation
memory, such as TRADOS.

Because glossaries can contain hundreds of lines of information, they are among the most time-consuming
components to translate.

Processing Options
You can use processing options to configure most PeopleSoft applications according to the needs. Processing
options enable you to supply parameters to control how a program functions. For example, processing
options enable you to:

• Specify defaults for certain form displays.

• Control the format in which information appears on reports.

• Change how a form displays information.

You translate all of the tabs and the processing option text on the processing option forms.

Forms
When you access an interactive program, a form appears. Each form contains a title and a variety of controls,
tabs, grid items, and hyper controls, all of which must be translated.
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Reports
Similar to forms, reports contain grid items, controls, and titles that must be translated. Column items and
section controls correspond to data dictionary items.

Tasks
PeopleSoft software contains task menus that enable access to subtasks, applications, and reports. As you
translate tasks, all task items and submenus appear together so that you can view them in context.

Some tasks must be translated with a different tool than that which you use to translate the task items.

User Defined Codes
User Defined Codes (UDCs) are codes and descriptions in the software that provide you with an easy way
to select a value from a list. UDCs are stored in tables within PeopleSoft software, and you access them
from these tables.

Each user-defined code contains a description of the option as well as a code for that option. You translate
only the descriptions; the codes remain the same in every language.

Resource Files
Resource files (for example, files with extensions such as .rc, .dll, .exe) are applications that are generated by
third-party tools (for example, Java and C++) that appear throughout PeopleSoft software. These items are not
PeopleSoft items, but they must be translated into the target language, or users will see source text. These
files include error messages, toolbar menus, and the legal disclaimer.

Miscellaneous Items
A few items in the PeopleSoft software interface cannot be included in any of the previous categories, and
PeopleSoft Translation Tools does not recognize them. These miscellaneous items are contained in specific
tables within the PeopleSoft software and include user-defined time periods and the names of the months. You
translate miscellaneous items by using the FASTR and Favorites applications.

Understanding the Translation Tools Interface
This section discusses:

• Information common to all tabs.
• Source and target panes.

Information Common to All Tabs
Many of the tabs on the Fix/Inspect forms in the PeopleSoft Translation Tools contain the same information.
You should be familiar with this information before using the PeopleSoft Translation Tools.

The examples in this chapter are taken from different translation tools. However, you can find the information
defined in all translation tools.
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View
The View tab contains display and option information for individual items, files, and objects.

Audit
The Audit tab contains audit trail information for an individual translation item or for an object.

The status totals are the total number of translation items that were transferred when the last Delta Process
was run.

The translator or translation audit information identifies who last translated an item, when it was translated,
and so on.

The audit trail information provides detailed information about who accessed an item.

Glossary
The Glossary tab contains the glossary information for items that have glossaries. Each Glossary tab contains
header information, for example, the data item name and a description.

The Glossary tabs contain two panes. The top pane is the source pane or untranslated text. The bottom pane
is the target pane or translated text. You cannot always change the text in these panes. The Translating the
Data Dictionary section of this guide explains all you need to know about the Glossary tab and translating
data dictionary items.

Source and Target Panes
The source and target panes are located in the common area. The common area is located in the lower section
of almost all of the forms of the Translation Tools. When you click an item in the detail area, the current source
and target text appears in the fields in the common area.

Pane Explanation

Source Displays the term or text in source language. The
application also uses this field to store variable-length
terms or text for use by PeopleSoft Translation Tools.

Target Displays the term or text in target or translation language.
The application also uses this field to store variable-length
terms or text for use by PeopleSoft Translation Tools.

All common areas in the Translation Tools forms contain status, change type, and skip reason information
for the individual item that you select to translate.

Accessing the Translation Tools
This section provides an overview of translation tool navigation and discusses how to access translation tools.
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Understanding Translation Tool Navigation
You access all the PeopleSoft translation tools through the Translation Applications menu (GH791). On the
Translation Applications menu, all translation applications appear in a tree. When you access any of the
translation tools for the first time, the system displays default information. When you access the tools; you see
the information that you entered when you last quit the program (for example, product code, status, and so on).
No translation items appear until you search for them.

Accessing Translation Tools
To access any translation tools:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator.
The Senior Translations version of the program automatically updates the translation item status to 11
(Complete) from a status of 20 (Untranslated) or 25 (Edit/Review).
The Junior Translations version of the program automatically updates the translation item status to 25
(Edit/Review) from a status of 20 (Untranslated). If the item is already at a status 25, the status does not
change automatically.

2. To begin translating, click Translation Tools, and then select one of the translation applications (for
example, F7920: Resource Text Translations (RTT).

3. Click OK.

Note. Subsequent navigations in the Translation Tools documentation assume that you are a senior
translator.

Reviewing Audit Information for a Delta Process
You can review the audit information for a Delta Process to ensure that the Delta Process has been run over the
items that you want to translate. The Delta Process determines what development changes have occurred in
PeopleSoft translation tables over a specific period. The process compares the PeopleSoft translation tables,
as they are at the time that you run the process, with the production or mastered versions, as they were
when you last ran the process.

To review audit information for a Delta Process:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then Translation Tools.

2. On the View tab, click a translation tool, and then select the Audit tab.
3. Review appropriate fields.

Setting PeopleSoft Translation Tools Options
You can configure the appearance and performance of the PeopleSoft Translation Tools to suit the translation
style and to enable the system to assist you in translation.

This section discusses how to:
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• Set display options.
• Select the Move by Status feature.
• Move from item to item.
• Use auto hot keys.

Setting Display Options
You access the translation applications from a tree. You can configure the tree to either limit or expand the
view of the data items that you want to translate. Click these options to define the view.

Source Display only the source text.

Target Display only the target text.

Both Display both the source and target text.

Select the Move by Status Feature
The Move by Status feature enables you to specify which translation items appear when you finish translating
the current item. The Move by Status feature moves to the next item at the status that you specified on the
Find/Browse (Work With . . .) form.

For example, if you are working only on translation items at status 20 (Untranslated) with the Move by
Status feature selected, the system displays only those items at status 20. You can specify any status in
the translation process.

To select Move by Status:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then select any of these translations tools:
• F79750: Forms Design Aid (FDA).
• F79760: Report Design Aid (RDA).
• F98306: Processing Options (PO).

2. On the Find/Browse form (Work With . . .), complete the Status field and click Find.
The status that you specify here is the status at which the system displays the records when you select
Move by Status.

3. Select an item from the detail area and click Select.
4. In the translation application that you are using, select the Move by Status option.
5. Enter the translation in the Target field and click OK.
The translation tool saves the translation and then displays the next item with the same status.

Moving from Item to Item
PeopleSoft Translation Tools enable you to move from item to item without having to quit the translation tool
in which you are working. You have two options that enable you to move from item to item:

• Move Previous and Move Next.
• Previous and Next.
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Using the Move Previous or Move Next Options
The Move Previous and Move Next options enable you to view the items in the detail area of the previous
Work With form. You can use both of these options to move from item to item in the detail area of the
Work With form on which you searched for items.

You can use the Move Previous and Move Next options only in these PeopleSoft Translation Tools:

• F79750: Forms Design Aid (FDA).
• F79760: Report Design Aid (RDA).
• F98306: Processing Options (PO).

Using the Previous and Next Options
You use the Previous and Next options for much the same reason that you use the Move Previous and Move
Next options. The Previous and Next options, however, are different in these ways:

• They function independently of the Move by Status option.
• They move to the next or previous item in the detail area of the previous Work With form regardless of
whether you select Move by Status.

While you can use the Previous and Next options in all of the PeopleSoft Translation Tools, you might find
that you do not need them in the tools that have the Move Previous and Move Next features.

Using Auto Hot Keys
A hot key is a key sequence that automatically launches a shortcut when pressed (for example, CTRL + C is a
hot key for the command Copy). The Auto Hot Key feature enables you to automatically copy the source hot
key into the target translation. Alternatively, you can manually copy the hot key from the source field into the
target field if the source and target hot keys are the same.

Checking the Spelling of Translations
This section lists a prerequisite and discusses how to:

• Check spelling manually.
• Check spelling automatically.

Prerequisite
Close all sessions of Microsoft Word before you run spell check in PeopleSoft Translation Tools. If Microsoft
Word is open when you run spell check, Microsoft Word might shut down without saving any work that you
have open.

Checking Spelling Manually
Before you advance to the next item to be translated, you can check the spelling of the item. The Spelling tab
highlights any misspelled words.

To check spelling manually:
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1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then select any translation tool.

2. Locate and select any translation item other than a glossary item.
3. Select Spell Check from the Form menu.
Misspelled words appear in red.

4. Correct any spelling errors.
5. Click one of these options:
• OK
The PeopleSoft Translation Tool saves the translation, updates the status, and displays the next item in
the Source data field.

• Save
The PeopleSoft Translation Tool saves the translation and updates the status.

Checking Spelling Automatically
You can specify that PeopleSoft Translation Tools automatically spell check the translations as you enter them.
To do so, select the Auto Spell Check option. This task demonstrates how to select the Auto Spell Check option
in the F7920: Resource Text Translations tool. You can use the Auto Spell Check feature in almost any tool.

To check spelling automatically:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translation
(RTT).

2. On Work With Resource Text Translation, complete the Selected File Name, Status, and Language fields
and then click Find.

3. Click an item in the tree menu and then click Select.
Alternatively, you can double-click a translation item in the tree menu.

4. On the Resource Text Translation form, select the Auto Spell Check option.

Changing Item Status
This section provides an overview of item status and discusses how to change item status manually.

Understanding Item Status
Each time that you revise a translation item and click OK, the system automatically updates the item status.
The next status that the system selects in the translation process depends on which version of the tool you
are using. This table describes the versions and the next status to which the system moves a translation
item when you click OK.
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Translation Tool Version Assigned Status

Senior Translations 11 (Complete) from a status of 20 (Untranslated) or 25
(Edit/Review)

Junior Translations 25 (Edit/Review) from a status of 20 (Untranslated)

If the item is already at status 25, the status does not
change.

You can manually change the status of the translation process. For example, if you are using a Senior
Translations version and you are unsure whether the item is translated accurately, you can change the item to
25 (Edit/Review) to indicate that it should be reviewed.

Changing Item Status Manually
To change item status manually:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On Work With Resource Text Translation, complete the Selected File Name, Status, and Language
fields, and then click Find.
The default value in the Status field comes from a processing option for the version that you are using.
The default value in the Language field comes from the PeopleSoft user profile.

3. Select an item and click Select.
4. Translate the item and click OK.

The F7920: Resource Text Translations (RTT) tool saves the translation with the appropriate status code based
on the version (junior or senior) that you are using.

Entering Translations Manually
This section provides an overview of manual translation and discusses how to enter translations manually.

Understanding Manual Translation
When you begin translating items, the system provides suggestions from previous translations. These
suggestions come from the source language database. The system populates the target fields with these
suggestions. You can enter translations manually, such as when the item is new and you do not agree with the
suggestion or when the suggestion is a “fuzzy” match that would require a great deal of editing. (A fuzzy
match is a source text that only partially matches the target text.)

You can enter translations manually on any Fix/Inspect form in any of the PeopleSoft Translation Tools.

Entering Translations Manually
To enter a translation manually:
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1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On Work With Resource Text Translation, complete the Selected File Name, Status, and Language
fields, and then click Find.

3. Select an item in the tree menu and then click Select.
Alternatively, you can double-click a translation item in the tree menu.
The Resource Text Translation form displays the source text.

4. In the Target field, enter the translated text.
5. Click OK.
PeopleSoft Translation Tools saves the translation and updates the status.

6. Click Next.
PeopleSoft Translation Tools displays the next item in the list.

Copying Translations
This section provides an overview of translation copying and discusses how to copy the source item.

Understanding Translation Copying
Many times the source text is a sufficient explanation for the target item or you cannot translate the target item.
You can use these features to copy information from the source text fields into the translation target fields:

Feature Description

Copy Source Copies the text for all source fields to the translation target
fields.

Copy Alpha Copies the translation for the alpha description into the row
and column translation fields. (Use this feature for data
dictionary translation only.)

Copy Row Copies the translation for the row description into the
translation field for the column description. (Use this
feature for data dictionary and translation tools only.)

Copy Previous Copies the translation for the last saved translation into all
translation fields.

Copy Tab Copies the translation from the Short Name field to the
Long Name field. (Use this feature for processing options
translation only.)

Note. For data dictionary items, always translate the alpha description first so that the copy functions are
available for the row and column translations.
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Copying the Source Item
If the source item has no translation in the target language, you can copy the source item into the Target field.

You should copy source text only to help you format the translations; you should never save the source text
as the translation. If the source text does not require translation, assign the item a status of 30 Other (Skip
Reason). Status 30 bypasses the translation for that item. If you do not assign status 30 to the item, the
system displays the source text.

To copy the source item:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On the Work With Resource Text Translation form, complete the Selected File Name, Status, and Language
fields and click Find.

3. Select an item and click Select.

The Resource Text Translation form displays the source item in the Source field.

4. Select Copy Source from the Form menu.

The source item appears in the Target field.

5. Translate the item.

6. Click OK.

Using Suggestions
This section provides an overview of suggestions and discusses how to:

• Search for suggestions manually.
• Search for suggestions automatically.
• Add translations as suggestions.
• Update and delete suggestions.

Understanding Suggestions
PeopleSoft Translation Tools ensure consistency and save time by enabling you to use items that have already
been translated. When PeopleSoft Translation Tools finds a previously translated item, it automatically
completes the Target field so that you can use the suggestion and immediately go to the next untranslated item.

Alternatively, you can search for translated items manually. When using suggestions, you should consider
whether you want to retrieve suggestions manually or let the system retrieve them automatically, and whether
you want to save the translations as suggestions.

The suggestions data field, located in the lower right of the translation tool forms, contains these entries:

• None.
No appropriate translations exist for this source term.

• Exists (Loaded).
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The data field contains a lightning bolt button, which indicates that a suggested translation is available for
this source term. When you click the button, the Suggestion -Search & Select form appears. You then can
search for the most appropriate translation for the source term.

• More Exists.
The data field contains a lightning bolt button, which indicates that more than one suggested translation is
available for this source term. When you click the button, the Suggestion -Search & Select form appears.
You then can search for the most appropriate translation for the source term.

• DD Default.
The data field contains a light bulb button, which indicates that appropriate translations are available for this
source term. When you click the button, the Data Dictionary Translation form appears.

• Not checked.
Based on the status of the term, the system did not search the database for any suggested translations.

You can use the Suggestions on any Fix/Inspect (Work With. . .) form in any of the PeopleSoft Translation
Tools except:

• F83100: FASTR Date Title.
• F83100: FASTR Column Headings.
• F91100: Favorites Relationships and Properties.

You also can access it directly From the Translation Tools menu (GH791) by choosing either Senior
Translations or Junior Translations, depending on the role, and then choosing Suggestions from the Form menu.

Searching for Suggestions Manually
PeopleSoft Translation Tools enable you to manually search for and use previously translated items. You
manually research translations when you are not satisfied with the default suggestions.

Searching for Suggestions Automatically
If you are translating items with a status 20 (Untranslated), you can use PeopleSoft Translation Tools to
automatically search for and use previously translated items. PeopleSoft Translation Tools alerts you if it finds
more than one option for the item that you are translating. You can make the search general or more specific
by selecting the number of characters that you want to search on in the Source term. For example, you can
specify the search by directing the software to retrieve only those items that match the first 40 characters of the
Source term. Alternatively, you can make the search more general by directing the software to retrieve only
those terms that match fewer characters.

Updating and Deleting Suggestions
After you have created a suggestion for one item of source text, you cannot add an additional suggestion for
that exact source text. If the record exists, the system does not add another.

You might update the suggestion if:

• The text has changed slightly.
• The space requirements have changed (you have either more or less space for the translation).

You might delete the suggestion if:

• The source text is obsolete.

• The suggestion was added by mistake.
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• It is easier to delete the suggestion and enter another than to update the current one.

Searching for Suggestions Manually
To manually search for suggestions:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On Work With Resource Text Translations, complete the Selected File Name and Language fields and
then click Find.

3. Select an item in the detail area, and then click Select.

Alternatively, you can double-click a translation item in the detail area.

4. On the View tab of Resource Text Translation, ensure that the Suggestions option is selected.

5. In the Length field, enter the number of beginning characters that you want PeopleSoft Translation Tools to
search when finding matches.

For example, if you enter 5, PeopleSoft Translation Tools uses the first five characters of source text to
search for and retrieve matching translated items.

• If PeopleSoft Translation Tools finds only one term and the Target field is blank, it automatically loads
the text into the Target field. If the existing translation is accurate for the item, continue to step 7.

The Suggestion Search & Select button also appears here.

• If PeopleSoft Translation Tools finds more than one term, it displays the Suggestion Search Select button
with the text More Exists.

6. Select Suggestions from the Form menu.

Note. The compressed description in the Source Search Text data field contains the search text without
spaces, slashes, dashes, commas, or other special characters. The compressed description is the field used
in the Data Dictionary Name Search.

7. To search for translations, on Suggestion - Search & Select, enter search criteria in the appropriate fields
on the form and click Find.

8. Select the translation that you want to use from the detail area, and click Select.
The Resource Text Translation form appears, displaying the translation that you chose from the Target
data field.

9. Click OK.
The PeopleSoft Translation Tool saves the translation and updates the status.

10. Click Next to move to the next translation item.

Searching for Suggestions Automatically
To automatically search for suggestions:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).
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2. On the Work With Resource Text Translation form, complete the Selected File Name, Status, and Language
fields, and then click Find.

3. Click an item in the detail area, and then click Select.
Alternatively, you can double-click a translation item in the detail area.

4. Ensure that the Suggestions option is selected.
5. In the Length field, enter the number of beginning characters that you want PeopleSoft Translation Tools to
search on when finding matches.
For example, if you enter 5, PeopleSoft Translation Tools uses the first five characters of source text to
search for matching translated items.
• If PeopleSoft Translation Tools finds only one term and the Target field is blank, it automatically loads
the text into the Target field. If the existing translation is accurate for the item, continue to step 7.
The Suggestion Search & Select button also appears here.

• If PeopleSoft Translation Tools finds more than one term, it displays the Suggestion Search & Select
button with the text More Exists.

Note. The compressed description in the Source Search Text data field contains the search text without
spaces, slashes, dashes, commas, or other special characters. The compressed description is the field
that is used in the Data Dictionary Name Search.

6. Click the button or select Suggestions from the Form menu if you are not satisfied with the suggestion
that was loaded.

7. On Suggestion - Search & Select, select the translation that you want to use.
8. Click Select.
The Resource Text Translation Text form appears, displaying the text that you chose from the Translation
field.

9. Click OK.
The PeopleSoft Translation Tool saves the translation and updates the status.

10. Click Next to move to the next translation item.

Adding Translations as Suggestions
You can add the translations as a suggestion for you or other translators to use later.

To add a translation as a suggestion:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On Work With Resource Text Translation, complete the Selected File Name, Status, and Language
fields, and then click Find.

3. Click an item in the detail area, and then click Select.

Alternatively, you can double-click a translation item in the detail area.

4. On the View tab of the Resource Text Translation form, ensure that the Suggestions option is selected.

5. In the Target field, enter the translation for the current item, and perform one of these actions:
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• Click OK.
Automatically saves the translation to the code page as well as the Translations Suggestions (F7910)
table as a suggestion if the Suggestion option selected on and the suggestion does not already exist.

• From the Form menu, select Add Suggestion.
Saves the translation to the F7910 table.

Updating and Deleting Suggestions
You can update or delete a suggestion using the Translation Suggestion Search and Select (P7910S) program.
You can access this application from any of the PeopleSoft Translation Tools. The PeopleSoft Translation
tools themselves do not update or delete suggestions.

To update or delete suggestions:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator.
On PeopleSoft Translation Tools select a translation tool.
From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator. Select Suggestions from the Form menu, and
then complete steps 5 through 8. You might want to do this if you need to go directly to Suggestions to
perform maintenance on the suggestions.
These steps use the Resource Text Translations tool as an example.

2. On Work With Resource Text Translation, complete the Selected File Name, Status, and Language
fields, and then click Find.

3. Click an item in the detail area, and then click Select.
Alternatively, you can double-click a translation item in the detail area.

4. On Resource Text Translation, select the Suggestions option, and then select Suggestions from the form
menu.

5. On Suggestion - Search & Select, locate the record that you want to update or delete.
6. Select the record in the detail area, and then select Update Suggestions from the Form menu.
If no suggestions appear in the detail area, you must add one.

7. On Work With Translation Suggestions, complete the Source Search Text, Language, and Product Code
fields (if needed), and then click Find.

8. Select a record in the detail area, and then click OK.
9. If you want to delete the suggestion, click Delete and then go to step 9.
10. If you want to update the suggestion, click Select and then go to step 8.
11. Update or delete the suggestion in the Target field, and then click OK.
12. Click Cancel.
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Using Source and Target Preview
The PeopleSoft Translation Tools offer many features to help you further refine the data, structure, and
physical appearance of the translations. These features help you refine the translations:

Feature Description

Source Preview This feature enables you to view source objects as they
appear in the software. Use the source preview to review
software objects in the source language for content and
format as you make translation choices.

Target Preview This feature enables you to view target objects as they will
appear translated in the software. Use the target preview
to review the software objects in the target language for
content and format as you make translation choices.

These PeopleSoft Translation Tools have Source Preview and Target Preview:

• F79750: Forms Design Aid (FDA).
• F79760: Report Design Aid (RDA).
• F9203: Data Dictionary (DD) Alpha.
• F98306: Processing Options (PO).

To use source or target preview:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then select any translation tool with
source or target preview.

2. Select an item in the detail area.

3. From the Form menu, select one of these options:

• Source Preview

• Target Preview

Using Keyboard Shortcuts
Using keyboard shortcuts saves you valuable time when translating. You can use these keyboard shortcuts to
move between tabs and items on the PeopleSoft Translation Tools forms.

Keyboard Shortcut Description

CTRL+TAB Moves between tabs from left to right.

CTRL+SHIFT+TAB Moves between tabs from right to left.

ALT+X Moves to the next item on a Find/Browse (WorkWith. . .)
form.
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Keyboard Shortcut Description

ALT+V Moves to the previous item on a Find/Browse (WorkWith.
. .) form.

ALT+O or ENTER OK.

CTRL+END Moves to the last selection in the detail area.

Searching and Replacing Text
This section presents an overview of the search and replace workspace and discusses how to:

• Use wildcard characters.
• Define general search criteria.
• Define search text.
• Find and replace target items.

See Also
Chapter 14, “Understanding Jargon and Overrides,” Overrides and Jargon, page 87

Understanding the Search and Replace Workspace
The Search and Replace tool exists in all of the tools except:

• F83100: FASTR Date Title.
• F83110: FASTR Column Headings.
• F91100: Favorites Relationships and Properties.

When you replace a translation and save it, PeopleSoft Translation Tools enables you to proceed to the next
item on the list. Continue replacing translated items until you have completed the list for all of the applications.

The Search and Replace workspace consists of a form with three or four of these tabs: General, Application,
Search Text, and Find/Replace. The number of tabs depends on which translation tool you are using.

General Tab
When you access the Search and Replace tool from a PeopleSoft Translation application’s Find/Browse (Work
With. . .) form, the form that appears consists of the upper and lower common areas with the detail area in
between. The detail area of the General tab is the only area that is different for every application.

The General tab enables you to further define the search criteria. For example, if you know the form date
translated and the through date translated, you can limit the search to that period of translation.

Application Tab
When you access the Search and Replace tool from an application’s Find/Browse (Work With. . .) form, the
form that appears consists of several tabs. The Application tab is different for each of the four applications.
Each Application tab consists of data fields that you use to define the search and replace.
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The Application tab on Forms Design Aid (FDA) enables you to further define the search criteria. For
example, if you know the form name and the data item, you can limit the search to that form and the data
item that appears on it.

The Application tab on Report Design Aid (RDA) enables you to further define the search criteria. For
example, if you know the object name, you can limit the search for the text on only that object.

The Application tab on Processing Options (PO) enables you to further define the search criteria. For example,
you can limit the search according to PO text type.

The Application tab on Solution Explorer Tasks enables you to further define the search criteria. For example,
if you know the task ID, you can limit the search for the text on that object only.

Search Text Tab
When you access the Search and Replace tool from an application’s Find/Browse (Work With. . .) form, the
form that appears consists of several tabs. All Search Text tabs are the same for each application.

Find and Replace Tab
When you access the Search and Replace tool from an application’s Find/Browse (Work With. . .) form, the
form that appears consists of several tabs. The Find and Replace feature enables you to find specific search
strings of translated text for the application that you are in and replace them with a new or updated translation.
You can replace each instance individually or you can replace all instances. The Find and Replace tab is
the same for each application.

When you select the Replace Translation option, the system searches for the selected source translation that
matches the term in the detail area that you want to replace. When the system finds a match, the source
translation appears in the Source field, and the proposed replacement translation appears in the Target field.
You have these choices when you replace text:

Replace Option Description

Replace Replaces only current text and remains on that text.

Replace Next Replaces only current text and finds the next text match.

Replace All Replaces all text in the detail area with matching criteria
and returns to the top of the grid.

Using Wildcard Characters
You can use wildcard characters to expand the search or if you are not sure of the spelling of the search term.
Several types of wildcards exist. The PeopleSoft Translation Tools use an asterisk (*).

An asterisk substitutes a string of characters of any length at the beginning of the string, the end of the string,
or both. Asterisks specify 0 (zero) or more alphanumeric characters. You can use wildcards to obtain
special results. This table illustrates wildcard use in the Search and Replace tool (where string equals any
alphanumeric string).
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Search String Description
Search Text
Example Source Results Target Results

string* BeginWild Code* Code Page Pagina de codigo

*string EndWild *Code Purge Code Codigo de depuraci?n

*string* Total Wild *Code* Managerial Analysis
Code1

Cod de analisis
gerencial 1

string Exact Code Code Codigo

Defining General Search Criteria
Access the Work With Resource Text Translation form.

To define the general search criteria:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On the Work With Resource Text Translation form, complete any of these fields and click Find.
• Selected File Name
• Status
• Language

3. From the Form menu, select Search / Replace.
The system updates the header of the Search and Replace form with some of the information that you
entered in the header area of the Work With Resource Text Translation form, such as Selected File Name
and Language. However, the system does not update the Status field with the value from the Status field on
the Work With Resource Text Translation form. Instead, it supplies the default value of 11 (Complete)
because you normally want to search for completed items only.
Depending on the application from which you access the Search and Replace feature, different search
criteria appear. For example, if you access the Search and Replace feature from F0004: User Defined
Code (UDC) Types and the fields in the header contain values, the search criteria are the product code
and the language.

4. On the General tab, complete any of the search fields, and then click Find.

Note. You can search only for these statuses when using the Search and Replace feature: 11 (Complete),
20 (Untranslated), and 25 (Edit/Review).

After you define the general search criteria and review the results in the detail area, you can either define the
search text or find and replace target items.

Defining Search Text
To define the search text:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).
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2. On Work With Resource Translations, complete any of these fields and click Find:
• Selected File Name
• Status
• Language

3. From the Form menu, select Search / Replace.
4. On Search and Replace, select the Search Text tab.
The system updates the detail area of the Search and Replace form with the information from the General
tab.

5. To further define the search, complete any of the search fields, and then click Find:
• Primary Search
• Source
An option that specifies whether the system searches for a match on the source description first and then
the target description. If the system finds a match, it then checks the target description for a match based
on the search criteria chosen in the secondary search.

• Target
An option that specifies whether the system searches for a match on the target description first and then
the source description. If the system finds a match, it then checks the source description for a match
based on the search criteria chosen in the secondary search.

• Secondary Search
• Case Sensitive
An option that specifies whether the search is case sensitive. If you select this option, it applies to
the primary search that you did not select. For example, if Source is selected in Primary Search, the
case sensitivity option applies to the Target field.

• Equal To
An option that specifies whether the system returns items to the detail area for which the source and
target items match. If you select this option, the system returns only those items for which both the
source and the target items contain the string that you entered in the Source or Target field. If you do not
select this option, the system returns only items for which the source matches but target does not.
After you define the search text and review the results in the detail area, you can find and replace
target items.

Finding and Replacing Target Items
To find and replace target items:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On Work With Resource Text Translation, complete any of these fields and click Find:

• Selected File Name

• Status
• Language
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3. From the Form menu, select Search / Replace.
4. On Search / Replace, select the Find/Replace tab and complete these fields:
• Find
• Replace with

5. From the Form menu, select one of these options:
• Next
The system selects the next item in the detail area.

• Replace
The system replaces the current item in the detail area.

• Replace / Next
The system replaces the current item and then selects the next item in the detail area.

• Replace All
The system replaces all items in the detail area.

• Previous
The system selects the previous item in the detail area.

• Top
The system selects the uppermost item in the detail area.

You can find and replace these types of text strings:

• Text strings with other text strings only.
• Text strings with text strings containing spaces.
• Text strings with spaces only.
• Text strings with nulls.

This table illustrates a sample search. One carat (^) equals one space.

Search Text
Example Text String Type Find Field Text Replace Field Text Target Results

*Code* Other text strings *Código* C?dXigo C?dXigo

*Code* Text strings
containing spaces

Código* *C^^^?digo* C^^^?digo

Code* One blank Código* *^C?digo* ^C?digo

Code* More than one blank Código* *C?d^^^^igo* C?d^^^^igo

Code* Null Código* * (blank)
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Approving Target Items
You can use the Search and Replace Tool to approve target items; for example, target items changed by the
Multiple Release Exact Match program (P7903).

This section lists a prerequisite and discusses how to approve target items.

Prerequisite
Set the processing options for version ZJDE0003 (Quality Assurance) of the Translation Tools program to
36:Exact Match.

Approving Target Items
To approve target items:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On Work With Resource Text Translation, select Search / Replace from the Form menu without completing
any fields.
The system updates the header of the Search and Replace form with some of the information that you
entered in the header area of the Work With Resource Text Translation form, such as selected file name and
language. However, the system does not update the Status field with the value from the Status field on the
Work With Resource Text Translation form. Instead, it supplies the default value of 11 (Complete) because
you normally want to search for completed items only.
Depending on the application from which you access the Search and Replace feature, different search
criteria appear. For example, if you access the Search and Replace feature from F0004: User Defined
Code (UDC) Types and the fields in the header contain values, the search criteria are the product code
and the language.

3. On the General tab, complete these fields and click Find:
• Status
Filter Status = 36:Exact Match

• Language
• Last Translator
Last Translator = XTRANS (eXact TRANSlation)

4. Select a record in the detail area.
5. From the Form menu, select Review Approved to update items to 11 (Complete).

Saving Translations
When you save a translation, PeopleSoft Translation Tools saves the translation to the Code Page Environment
and perform these actions:
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If you click OK, the PeopleSoft Translation Tools saves the translation, updates the status code to 11
(Complete) in the compare environment, and automatically displays the next available item in these PeopleSoft
Translation Tools:

• F79750: Forms Design Aid (FDA).

• F79760: Report Design Aid (RDA).

• F98306: Processing Options (PO).

For all other PeopleSoft Translation Tools, you use the Next or Previous buttons to display the next
available item for translation.

If you click Save on the preceding applications, the current item is saved; however, the next available item
does not automatically appear.

The status that you apply to a translated item depends on the status of the item when you opened it. If the
item’s status was 20 (Untranslated), each tool updates the status to the default value that is specified in the
processing options for that tool, which is either 11 (Complete) or 25 (Edit/Review).

Important! You must save the work after each translation. The system does not prompt you to save the
translation before choosing another item, so be sure to save the work.
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Translating Resource Text

This chapter provides an overview of resource files and discusses how to:

• Translate service pack resources.
• Translate resource text.

Understanding Resource Files
Resource files (for example, files with extensions such as .rc, .dll, .exe) are the applications that are generated
by third-party tools (C++ and Java). They appear throughout PeopleSoft products and include error messages,
toolbar menus, and the legal disclaimer. Resource file items can be a single word or a short paragraph. To
ensure consistency, one translator should translate all resource files for one language using the Resource Text
Translation program (P79201). Resource files occur throughout PeopleSoft software; they are grouped by
file rather than product code.

You translate all resource items using the F79201: Resource Text Translations (RTT) tool. In addition to
translating items, you can retrieve and use existing translations, check the spelling of the text, change the status
of an item, save translated items, search for and replace target text, and so on.

You have three options when translating resource files. You can enter a translation manually, copy the source
text that has already been translated manually, or use suggestions.

Many items in the resource files include a hot key. Hot keys can be localized to a specific language, but
standards should be followed for consistency.

Because resource files are not grouped by product code, you generally translate them in the order that they
appear in the tool (RTT). Resource text, however, is grouped by the resource file and parent identifier.

Note. Resource files have names such as jdeuser.dll, and the items are contained in these files. The parent
identifier is sometimes just a number (for example, 128), and does not necessarily tell you what kind of item
you are translating. Often, you can deduce that you are working with a dialog box, but nothing as specific
as the Calendar or Calculator.

Translating Service Pack Resources
This section provides an overview of service pack resource translation and discusses how to translate service
pack resources.
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Understanding Service Pack Resource Translation
Resource Text Translation (RTT) comes from DLLs and Java files that are part of SourceSafe and the service
pack trees. This information is not part of standard pristine data sources or tables. The translating service pack
resources process includes an extract and update for the resources in the DLLs and Java files.

The Resource Life Cycle is associated with service packs (for example, SP14, SP15, and so on) and not a
major release (for example, B9 or 8.10).

Translating Service Pack Resources
You run several different processes when you translate service packs. the programs could be in a different
location (Rtt.exe, for example). These steps provide high-level guidance so that you do not miss any of
the steps in the process.

Your mastering group should perform some of these steps, and the translation group should perform others.
These steps indicate which group should perform which task.

To translate service pack resources:

1. The mastering group extracts the RTT files into a source Delta environment using the Rtt.exe.
2. The mastering group runs the Delta Process using the Translation Delta Process program (R79800) for
each compare environment for each tier.

3. The mastering group runs the Check Delete Status program (R79802) to update orphaned records in
the status stable.
The process runs all languages simultaneously for each compare environment.

4. Either the translation group or the mastering group rebuilds the keys by language using either the Delta
Purge and Rebuild Process program (R79801) or the Resource Text Translation program (P79201).

Note. Any translator can perform this step. Use the Rebuild Key option from the Form menu of the
Resource Text Translation program (P79201).

5. The translation group translates the source items using the Resource Text Translation program (P79201).

Translate each language.

6. The mastering group runs the Delta Purge and Rebuild Process program (R79801) to purge the records
that are set to a status of 99 (Purge from System).

Run this process once for each language.

7. The mastering group builds the package (.dll and .jar files) using the Rtt.exe.

Run this process once for each language.

8. The translation group checks the package (.dll and .jar files) using Visual C++, PeopleSoft
EnterpriseOne Standalone, and language install on a web server for Java and HTML.

Check the package for each language.

Note. Everything done by language needs to use the appropriate setup for the language and code pages.

Translating Resource Text
This section provides an overview of resource text translation and discusses how to translate resource text.
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Understanding Resource Text Translation
Resource Text Translation (RTT) finds and displays items by matching the search criteria that you enter in the
fields or on the Query by Example (QBE) line. The information that you enter in these fields remains until you
change it. The files that appear contain the items that you will translate.

Translating Resource Text
To translate resource text:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F7920: Resource Text Translations
(RTT).

2. On Work With Resource Text Translation, complete the Selected File Name, Status, and Language fields,
and click Find.

Note. The F7920: Resource Text Translations (RTT) tool retrieves the resource items that match the
search criteria and displays them in the detail area.

Any language that you search on that is not specified in the user profile is read-only.

If you leave any of the fields blank, the system uses the default value of * (asterisk), which equals
a search for all items.

3. On Work With Resource Text Translation, select a record in the detail area and then click Select.
4. On Resource Text Translation, click the item in the menu tree that you want to review or translate.
5. Enter the translation in the Target window, and then click OK to save it.
You must enter a translation. The system does not save blank records.
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Translating the Data Dictionary

This chapter provides an overview of data dictionary translation and discusses how to:

• Translate alpha, row, and column descriptions.
• Translate glossary entries.
• Copy existing items.

Understanding Data Dictionary Translation
This section discusses:

• Data dictionary items.
• The data dictionary translation process.
• Data dictionary items and the Forms Design Aid (FDA) translation tool.
• The SAME shortcut.
• Data dictionary translation tools.
• Data dictionary item navigation.
• Data dictionary space constraints.

Data Dictionary Items
Data dictionary items include check boxes, radio buttons, text fields, grid items, and help text that appear
throughout PeopleSoft software. The data dictionary stores the descriptions for these items. Each data
dictionary item contains at least one of the these components:

• Alias: an alpha code given to a data dictionary item.
• Alpha description: the title that appears in the help text in the software when you press F1.
• Row description: the text that describes controls.
• Column description: the text that describes grid items.
• Glossary: the full description text in paragraph form when you press F1.

The Data Dictionary Translation Process
Translating a data dictionary item is an iterative six-step process, as described here:

1. Select the data dictionary item that you want to translate.
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2. Review both the data item components for context and the suggestions for appropriateness.
3. Enter the translation manually or copy existing translations.
4. Check the spelling.
5. Review space constraints.
6. Save the translation and start the process over again.

The PeopleSoft data dictionary translation tools use many of the same processes repeatedly.

See Also
Chapter 14, “Understanding Jargon and Overrides,” Overrides and Jargon, page 87

Data Dictionary Items and the FDA Translation Tool
The data dictionary translations that you enter are the translations for their corresponding forms. Therefore,
when you access a form in the FDA Translation Tool (P797501), the data dictionary translation appears as the
field description unless the item has an override. The status for the form items in the FDA Translation Tool
remains at a status of 20 (Untranslated) until you save the translation. When you save the translation, the item
moves to a status of 15 (FDA/RDA DD Default).

When you edit a data dictionary translation, FDA items that are not overridden by a language are set to a status
of 25 (Edit (Review)). You can view the list of language-overridden and non-overridden forms in the English
Non-Overridden Forms box. When you access the affected forms in the Forms Design Aid (FDA) Translation
Tool, the edited translation appears in the Translation field.

The *SAME Shortcut
When you are translating an alpha description that has jargon applied, two fields appear for both the Source
and Target columns: Alpha - Base and Alpha Description. If the translation of the base description is correct
for the alpha description, you can reuse the base description by entering *SAME in the Translation field.

Data Dictionary Translation Tools
You use three data dictionary language translation tools to translate data dictionary items:

• F00165 (GT92002): Data Dictionary (DD) Glossaries.
• F9202: Data Dictionary (DD) Row / Column.
• F9203: Data Dictionary (DD) Alpha.

You access all of these tools through the Translation Tools menu (GH791).

Data Dictionary Item Navigation
When you access any of the data dictionary translation tools, the data items for the system and status that
you specified appear. You can select an item by double-clicking it or by choosing the item in the detail
area and clicking Select.

If you are looking for a specific item, you can use the Find button to search by alias. You also can search
for a specific item from a different system. To display all items in another system, specify a new system in
the Product Code field. You can view and edit translation items in a product code that is not specified in
the user profile.
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The Find/Browse (Work With . . .) form enables you to search for data dictionary items that require translation
or review. You can search for data items by product code, language, status, or all three. When you select an
item on one of these forms, you access the Data Dictionary Translations form.

Data Dictionary Space Constraints
A fixed amount of space is available for most data dictionary items. Alpha and row descriptions are allotted 40
characters, and column descriptions are allotted 20 characters for the top translation field and 20 characters
for the bottom translation field.

Although the translation might fit within the space allotted in the data dictionary translation tool, it might
not fit in the space allotted in the Forms Design Aid (FDA) Translation Tool. In other words, not all forms
allow 40 characters for controls.

A data dictionary item can be used on many forms, and those forms might allow different amounts of space.
The data dictionary translation tool finds the form that allows the least amount of space, and displays the
amount so that you can enter a translation that will fit in all forms. If you exceed the space available, a
warning message appears.

Note. To view a non-overridden form or a form with a translation override, click the form name in the English
Non-Overridden Forms box.

Translating Alpha, Row, and Column Descriptions
This section provides an overview of alpha, row, and column descriptions and discusses how to edit data
dictionary alpha, row, and column entries.

Understanding Alpha, Row, and Column Descriptions
The Data Dictionary Language Translation program (P799201) treats alpha descriptions as individual items
with their own status codes. When you translate, you must select to work with either alpha, or row and
column descriptions. Because most alpha descriptions have related row and column descriptions, you should
translate alpha descriptions first.

Row and column descriptions make up one item. One status code applies to both descriptions.

See Also
Chapter 3, “Using PeopleSoft Translation Tools,” Space Constraints, page 7

Editing Data Dictionary Alpha, Row, and Column Entries
You can edit Alpha and Row, and Column Entries dynamically. Editing them dynamically enables you greater
consistency when translating the data dictionary.

To edit data dictionary alpha or row, and column entries:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then select either F9202: Data Dictionary
(DD) Row / Column or F9203: Data Dictionary (DD) Alpha.

2. On the Fix/Inspect (Work With . . .) form, locate the records that you want to translate.
3. Select an item in the detail area and then click Select.
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4. On Data Dictionary Translation, select the Translation tab.
5. Complete these target fields as necessary:
• Alpha Description
Enter an alpha description translation.

• Row Description
Enter a row description translation.

• Column Title
Enter a column title translation for Column 1 or Column 2 or both.

6. Click OK.

Note. PeopleSoft Translation Tools accept a blank translation field only for Column Title 2 fields. If you
are unsure about a translation, change the status of the item to 25 (Edit/Review) and review it later.

Translating Glossary Entries
This section provides an overview of glossary translation and discusses how to:

• Translate glossary entries.
• Filter glossaries.
• Export glossaries.
• Translate glossaries in a translation memory tool.
• Import glossaries.
• Validate glossaries.

Understanding Glossary Translation
The glossary is the help text that you see when you press F1. As you translate items, review the glossary entry
to understand the context in which the data dictionary item is used. If you notice a mistake in the translated
glossary entry, you can edit it on the Glossary tab.

Note. PeopleSoft Translation Tools do not have a translation memory.

File Naming Conventions for Exported Glossaries
On export, an XML file is saved to the file path specified in the File Path (Folder) field. The file name is
created using the primary filters that are located on the Filter tab. The system uses these primary filters to build
the export file naming convention. The File Path (Folder) field is limited to 30 characters.

Language_ TranslationStatus_SystemCode_GlossaryGroup_ DataItemFrom_DataItemTo.XML

This example illustrates a typical file name:

S_20_01_D_A_L.XML

S = Spanish

_20 = Untranslated
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_01 = Address Book

_D = Glossary Group

_A = Data Items from A

_L = Data Items to L

Data items can be used in a range, such as A to L, or be specific, such as AN8 or LNGP.

In the file name on the XML tab, the wildcards (*) that you might have used on the Filter tab are substituted for
a plus sign (+). A plus sign should work across all ASCII code pages. Additionally, the system uses a default
path naming convention in the file name field. You should not change this naming convention.

Translating Glossary Entries
To translate glossary entries:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F00165 (GT92002): Data Dictionary
(DD) Glossaries.

2. On the Work With Glossary Data Dictionary Translation form, complete these fields and click Find.
• Product Code
• Glossary
• Status
• Skip from
• Skip to
• Language

3. Select a data item in the detail area and then click Select.
4. On Data Dictionary Translation, select the Glossary tab.
5. Enter the translation in the lower media object window.
6. Click OK to save the changes.
The data item moves to the next workflow status. When you click OK, Translation Tools saves the
changes and updates the status. The new glossary item will appear on the Translation tab the next time the
Delta Process is run.

Filtering Glossaries
You can filter the glossaries to select exactly the ones that you want to export. You might want to filter
glossaries to control the size of the output file.

To filter glossaries:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F00165: (GT92002) Data Dictionary
(DD) Glossaries.

2. On the Work With Glossary Data Dictionary Translation form, select the Filter tab, complete these
fields, and then click Find:
• Product Code
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• Glossary Group
• Status
• Skip From
• Skip To
• Language
Your user profile saves the values that you enter. These values reappear the next time that you log in.
If you are using TRADOS, you should limit the size of the export to 0.5 MB. TRADOS can receive only
files smaller than 0.5 MB in size. If the file is larger than 0.5 MB, TRADOS displays an error. You will
have to experiment to determine how many records equal 0.5 MB because glossary records vary in size.

3. Select the XML tab.
You now can export glossaries from PeopleSoft software.

Exporting Glossaries
After you complete the steps to filter glossaries, you must export the glossary data from PeopleSoft software.

To export glossaries:

1. On the Work With Glossary Data Dictionary Translation form, select the XML tab.
2. Ensure that a file path is specified as a root directory in the File Path (Folder) field.
A literal folder must be set up to handle the export or import (C:\ is the default folder). You must have
the same file path set up in the root directory as is specified here. The File Path (Folder) field is limited
to 30 characters.

3. Ensure that you have a file name in the File Name field.
4. Select one of these options:
• Source
Source text is exported.

• Target
Target text is exported.

• Remove Hard Return

Important! Selecting the Remove Hard Return option will remove all hard returns from the glossary
records. The import process does not reinsert the hard returns.

5. After you have entered the appropriate filters, specified the File Path (Folder) field, and determined the
text option, from the Form menu, select Export.

An XML file has been created.

6. You can now use the translation memory tool to translate glossaries.

Translating Glossaries in a Translation Memory Tool
PeopleSoft Translation Tools enable you to filter glossary information, including the alpha description,
and create an XML file.
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An example of a translation memory tool is TRADOS. The TRADOS Tag Editor enables you to use translation
memory, including the TRADOS Translators Workbench. After translation is complete, the Translation
Memory Editor saves translated data in an XML file. PeopleSoft Translation Tools then import the XML file
into the correct environment and code page in PeopleSoft software and include preview functionality, which
enables translators to validate the data.

To translate glossaries in TRADOS:

1. Complete the steps to export glossaries:
2. From the Form menu, select TM Editor.
3. Either the TagEditor for TRADOS will open or the TM Editor listed in the processing options will open.
4. Edit the glossaries using the translation memory functions.
5. Select File Save as Target and replace the XML file.
You now can import glossaries into PeopleSoft software.

Importing Glossaries
You import the glossaries into PeopleSoft Software similar to the way that you exported them. You do this
after you complete the steps to translate glossaries.

To import glossaries:

1. Ensure that you have saved the data in the XML file.

PeopleSoft software uses the primary filters to build the import file naming convention. Ensure that the file
name is exactly the same as when you exported it.

2. From the Form menu, select Import.

3. The status records are updated to Translation Memory at status 35.

You now can validate the glossaries.

Validating Glossaries
You can validate the glossaries after you import them back into PeopleSoft Software. You do this after you
complete the steps to import glossaries.

To validate glossaries in PeopleSoft software:

1. On the Work With Glossary Data Dictionary Translation form, select a record in the detail area, and
then click Select.

2. On the Data Dictionary Translation form, select the Glossary tab, and then verify that the glossary text
was imported correctly.

3. From the Form menu, select Target Preview, and then verify the format of the F1 help.
4. Validate all glossaries that you imported again.

Copying Existing Items
To copy existing items:
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1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then select either F9202: Data Dictionary
(DD) Row / Column or F9203: Data Dictionary (DD) Alpha.

2. On the Fix/Inspect (Work With . . .) form, locate the records that you want to translate.
3. Select an item in the detail area, and then click Select.
4. On the Data Dictionary Translation form, select the Translation tab.
5. On the Form menu, select one of these options:
• Copy Source
Copies the information from the source field to the target field.

• Copy Alpha
Copies the information for the alpha description into the row and column target field.

• Copy Row
Copies the information for the row description into the target field for the column description.

• Copy Previous
Copies the information from the last saved translation into the target field.

6. Click OK to save the changes.
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Translating Processing Options

Processing options (POs) enable users to control how an interactive or batch application manages data. Users
select processing options to configure the way that applications and reports look and function. This chapter
provides an overview of processing option translation and discusses how to:

• Display processing option items.
• Translate processing options.
• Use source and target preview.

Understanding Processing Option Translation
This section discusses:

• The processing option translation process.
• The processing option translation tool interface.
• Processing option tool features.

The Processing Option Translation Process
Within PeopleSoft software, users work with forms to access, view, and enter information. These forms are
made up of many items, such as radio buttons, text fields, check boxes, and data dictionary-based items.

To users, processing options appear as tabbed forms containing fields, drop-down menus, buttons, and other
objects found on system forms. Users use these objects by entering information into these fields, selecting
options from these drop-down menus, clicking buttons, and so on.

When users place their cursor over the tab name, a definition of the tab appears. You must translate both the
tab name and its definition. In Processing Option Text Translation, the tab name appears followed by each
object that appears on a tab. Use the PO Translation Tool to translate items from the source language into the
target language.

You translate all processing options using the Processing Options Translation Tool. In addition to translating
items, you can retrieve and use existing translations, use spell check, change the status of an item, save
translated items, and view glossary definitions.

Because processing options are written in paragraph form and can contain hundreds of lines of information,
they are typically one of the most time-consuming components to translate.
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The Processing Option Translation Tool Interface
The Processing Option Text Translation form contains three tabs: View, Audit, and Glossary. Use these
tabs to complete all translation requirements, including changing translation status, viewing item history,
and comparing with the glossary content.

Processing Option View Tab
The View tab displays a consolidated view of information for each PO. Use it to perform actual translations,
change item status, review translations, view object information, and so on.

The View tab provides the status and description followed by the translation of the description for the selected
processing option. You can view the source, translation text, or both depending on which of these options
you select:

• Source
• Target
• Both

Processing Option Audit
The Audit tab displays historical and statistical information for each PO item. Use it to view when the item
was last translated, how many items are not translated, who last translated the item, and so on.

Processing Option Glossary
The Glossary tab contains glossary information (including the Data Item Help ID Override) that is assigned to
a data dictionary item. Use it to make contextual comparisons in order to more accurately translate an item.

Processing Option Tool Features
The Processing Option Text Language Translation tool has many features to assist you.

Get Specs
From the Form menu, you can select Get Specs. This selection downloads the latest specifications for forms
and processing options for the current release. You use this feature when you find discrepancies between the
software and preview of the forms and POs.

Top
From the Form menu, you can select Top to bring you back to the first item of the list in the current template
that you are translating. You use this feature when translating processing option templates that are very long.

Data Dictionary Glossary Exit
From the Form menu, you can access the Data Dictionary translation tool. You can use the Data Dictionary
glossary selection to update or add a data dictionary translation.
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Displaying Processing Option Items
The F98306: Processing Options (PO) Translation Tool enables you to search for and display PO items by
product code, language, status, object name, or any combination of these criteria in the detail area. Searching
for items using these criteria enables you to specify the PO items to display.

To display processing option items:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F98306: Processing Options (PO).

2. On the Work With Processing Option Text Translation form, complete any of the these fields, and click
Find:
• Product Code
• Language
• Status
Select this option to see all the details for the items in the detail area. To return to a summarized view,
clear the option.

3. In the detail area, select the item that you want to translate and click Select.
4. Translate the item.
5. Click OK.

Translating Processing Options
You can enter translations manually, copy the source language, or use a previous translation. This section
provides an overview of processing option space constraints and discusses how to copy description data.

Understanding Processing Option Space Constraints
For each item in the Source Tab Page or the fields in the Source Tab Page, a fixed amount of space (40 bytes)
is available for the target text. Because translations usually require more space in most target languages than
they do in source languages, you might have to abbreviate the translations. As you type a translation, the
Processing Options Translation Tool keeps track of the number of bytes that are used. When you exceed the
40 bytes allotted, the cursor stops, preventing you from entering any more characters. When this happens,
either abbreviate the translation or use another term.

See Also
Chapter 3, “Using PeopleSoft Translation Tools,” Space Constraints, page 7

Copying Description Data
If no translation exists for the source term, you can use the Copy Source option to copy the source text term
into the target text field. This copy capability helps you maintain the formatting of the source text.

To copy description data:

PeopleSoft Proprietary and Confidential 45



Translating Processing Options Chapter 6

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F98306: Processing Options (PO).

2. On the Work With Processing Option Text Translation form, locate the processing option records that
you want to translate.

3. Select an item in the detail area, and click Select.
The Processing Option Text Translation form appears, displaying the status, source description, and
target description in the common area.

Note. Tabs control the processing of the associated items.

To see the processing option in context, you can select either Source Preview or Target Preview from
the Form menu.

4. Double-click the Media Object Column in the detail area to select the desired item tab for translation.
A green check mark in the Media Object Column identifies the item as translated.
A red X in the Media Object Column identifies the item as untranslated.
The data for the selected tab appears in the common area with the data initially displayed in the source and
target (Tab-Page), each with two short data fields.

5. Translate the source text on line 1.
6. From the Form menu, select Copy Tab.
The term is copied from line 1 to line 2 (top to bottom).

7. Click OK to save the translation.
When you click OK, the system saves the translation, updates the status, and displays the next item of the
chosen status in the Source data field.
When you click Save, the system saves the translation and updates the status, but does not move on to
the next item in the list.

Using Source and Target Preview
The PeopleSoft Translation Tools offer many features to help you further refine the data, structure, and
physical appearance of the translations. These features help you refine the translations:

• Source Preview.
This feature enables you to view source objects as they appear in the software. Use the source preview to
review software objects in the source language for content and format as you make translation choices.

• Target Preview.
This feature enables you to view target objects as they will appear translated in the software. Use the
target preview to review the software objects in the target language for content and format as you make
translation choices.

These PeopleSoft Translation Tools have the Source Preview and Target Preview features:

• F79750: Forms Design Aid (FDA).
• F79760: Report Design Aid (RDA).
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• F9203: Data Dictionary (DD) Alpha.
• F98306: Processing Options (PO).

To use source or target preview:

1. From the Translation Tools menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then select any translation tool with
source or target preview.

2. Select an item in the detail area.
3. From the Form menu, select one of these selections:
• Source Preview
• Target Preview
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Translating Forms

This chapter provides an overview of form translation and discusses how to:

• Translate forms.
• Use overrides.

Understanding Form Translation
This section discusses:

• Form translation.
• The form translation process.
• Single line items.
• The FDA tool.

Form Translation
Within PeopleSoft software, users work with forms to access, view, change, and enter information. Forms
consist of many items, such as radio buttons, text fields, check boxes, and column headings that are based on
data dictionary items.

Forms can be accessed from multiple PeopleSoft programs and menus. The Form Name begins with the letter
W, followed by the application code and a letter. For example, in the Form Name W0101A, W indicates that it
is a form, 0101 indicates that the form belongs to program P0101, and A indicates that it is the first form for
the application. When you translate forms, you translate all the single line items for that form, such as form
title, controls, menu hyper controls, grids items, and so on.

You use the F79750: Forms Design Aid (FDA) translation tool to translate form items from the source
language into the target language. (Only applications that are created using the PeopleSoft application Forms
Design Aid are translated using the F79750: Forms Design Aid (FDA) translation tool.) The Forms Design
Aid (FDA) translation tool:

• Displays form items in the context that they appear in the PeopleSoft software
• Displays related data dictionary items when available
• Contains reference features
• Tracks productivity
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The Form Translation Process
Translating form items requires more than just looking at a term and entering a translation. The terminology
you use depends greatly on the context in which the term is used.

For example, the word job might refer to an employee’s position in a human resources context, but might
refer to batch processing in an accounting context. So the translation you use in one system might not be
appropriate in another.

This concept is especially critical when translating forms because an individual form might be used in more
than one system. In these instances, you must ensure that the translation is appropriate in context for both
systems.

As you translate forms, you must pay attention to overrides, context, and proposed translations.

Note. No field exists on the form for you to check if you want to apply a language override.

See Also
Chapter 14, “Understanding Jargon and Overrides,” Overrides and Jargon, page 87

Single Line Items
Single line items are the individual items that make up a form. These items, such as controls and grids, relate
to a data dictionary item. The base data dictionary description is used for these items unless an override is
applied. You can translate these single line items within a form:

Single Line Item Explanation

Title In PeopleSoft Translation Tools, the form title appears in
the upper left hand corner of PeopleSoft software forms
and beneath the Form folder in the menu tree of the Forms
Design Aid Text form.

Control Controls are the text fields, check boxes, static text, and
radio buttons that appear in PeopleSoft forms. Many
controls correspond to a data dictionary item.

Menu Hyper Controls In PeopleSoft software, menu hyper controls access
applications and forms. They are the options available from
the drop-down menus at the top of PeopleSoft forms as well
as from the Exit bar.

Tabs In PeopleSoft forms, tabs act as separators for groups of
controls. Users click the tabs to display a new group of
controls. Tabs appear in the menu trees (as for controls),
but are labeled as tabs in the translation area when you
select them.
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Single Line Item Explanation

Grid Items Grid items are row and column headers for the table. Grid
items correspond to the column description for a data
dictionary item. On a form, they are the column titles in the
detail area.

Text Variables In PeopleSoft software, multiple line items are used for text
strings and runtime text substitution. Text variables are
stored as strings and can be used as an alternative to hard
coding text strings in assignments. Developers use text
variables instead of hard-coded text because text variables
are easier to maintain. You translate text variables; you do
not translate hard-coded text.

The Forms Design Aid (FDA) Translation Tool
The F79750: Forms Design Aid (FDA) Tool is designed to provide contextual translation. The tool uses tree
structures on different tabs to define the context. You use the tabs on this form as well as the features from
the Form menu to review and translate FDA items.

Forms Design Aid View
The View tab displays the individual items within a form. The translation functions that appear in the common
area at the bottom of the form do not change. You can display forms, select the items you want to translate,
enter translations, change the status of an item, and perform various other tasks related to translating items.
When you have selected a form title, a green arrow displays next to the Target data field to assist you in
determining where you are in the list.

Forms Design Aid Audit
The Audit tab displays the statistics for items contained in the form. You cannot enter or change any of the
displayed items. The data field information in the common area remains the same as on the original View tab.

Forms Design Aid Task
The Tasks tab enables you to view tasks from within the F79750: Forms Design Aid (FDA) application. You
translate tasks from the Task Language Translation program (P799000).

Forms Design Aid Data Dictionary
The Data Dictionary tab enables you to view the Alpha, Row, Column, or FDA text that appears on the form
within the F79750: Forms Design Aid (FDA) application. You translate data dictionary items from the Data
Dictionary Language Translation program (P799201). Double-click a data dictionary item in the tree to access
the Data Dictionary Language Translation program.

Forms Design Aid Glossary
The Glossary tab enables you to view a glossary for a data item. You can view the source glossary on this tab,
but you cannot revise the glossaries on this tab. You translate data dictionary items and glossaries from the
Data Dictionary Language Translation program (P799201). Double-click a data dictionary item in the tree on
the Data Dictionary tab to access the Data Dictionary Language Translation program.
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Forms Design Aid Processing Options
The Processing Option tab enables you to view processing options associated with a program. You translate
processing option items from the Processing Option Text Translation program (P7998306). Double-click an
item in the menu tree to access the Processing Option Text Translation program.

Entering Form Translations
This section provides an overview of form space constraints and discusses how to:

• Translate tabs, controls, and titles.
• Translate menu hyper items.
• Translate grid items.

Understanding Form Space Constraints
Grid items, titles, and certain controls (radio buttons, text boxes, and static text) are measured in pixels, while
menu hyper items, tabs, and the remaining controls are measured in characters. Because terms might take
up more space in the Target language than in Source language, it can be difficult to meet space constraints,
and you may have to abbreviate the translations.

You can view the space available and space used in the Text Information area of the Forms Design Aid Text
form. As you tab out of a field, the system calculates the space used. If you exceed the space available, the
cursor stops, and you must shorten the translation before you can save it.

See Also
Chapter 14, “Understanding Jargon and Overrides,” Overrides and Jargon, page 87

Translating Tabs, Controls, and Titles
Tabs, controls, and titles are all translated in the same way. When you select one of these items, the Source
term appears in the Source field, and you enter the translation in the Target field.

To translate tabs, controls, and titles:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F79750: Forms Design Aid (FDA).

2. On Work with Forms Design Aid Text, complete these fields and click Find:

• Product Code

• Status
• Language
• Status Details

This option enables you to see all of the details for the items in the detail area. To return to a summarized
view, turn this option off.

3. Click an item in the detail area and click Select.

4. On Forms Design Aid Text, click the View tab and then click an item in the menu tree.
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5. Enter the translation in the Target data field.
6. Click OK to save the translation.
When you click OK, the system saves the translation, updates the status, and displays the next item of the
chosen status in the Source data field.
When you click Save, the system saves the translation and updates the status, but does not move on to
the next item in the list.

Translating Menu Hyper Items
When translating menu hyper items, you must translate both the long and short text descriptions. Each menu
hyper item also has a keyboard shortcut, or hot key, and, if a menu hyper item is associated with the text
descriptions, this key must be included in the translation. This table describes the parts of a menu hyper item:

Menu Hyper Item Component Description

Menu hyper items short text descriptions Short text descriptions are the abbreviated menu options
that access applications.

Menu hyper item long text descriptions Long descriptions provide an unabbreviated description of
menu hyper items.

Hot keys Hot keys are the keyboard shortcuts used to select menu
options. Users can select a menu option by pressing Alt +
(hot key). A letter in the menu option acts as the hot key
and is indicated by & (ampersand) preceding the letter.
For example, the menu hyper short description File (&F)
indicates that the hot key for the File option is F.

Note. If you have the literal & (ampersand) in the translated text, you must enter && (two ampersands) to
represent the symbol. If you do not enter && (two ampersands), the software represents the translation as
a hot key.

When you select a menu hyper item, both the menu hyper short and menu hyper long text descriptions appear
in the common area of the Forms Design Aid Text form.

To translate menu hyper items:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F79750: Forms Design Aid (FDA).

2. On Work with Forms Design Aid Text, complete these fields and click Find:
• Product Code
• Status
• Language
• Status Details
This option enables you to see all the details for the items in the detail area. To return to a summarized
view, clear this option.

3. Select an item in the detail area and click Select.
4. On Forms Design Aid Text, select a menu hyper item in the menu tree.
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Both the short and long text descriptions appear in the common area.
5. Type a translation for the menu hyper item short description.
6. Type a translation for the menu hyper item long description.
7. Click OK.
When you click OK, the system saves the translation, updates the status, and displays the next item of the
chosen status in the Source data field.
When you click Save, the system saves the translation and updates the status, but does not move on to
the next item in the list.

Translating Grid Items
Grid items are the column headings that appear in the detail area of PeopleSoft forms. Each grid item can
contain multiple words. Two lines are allocated to each grid item (Column 1 and Column 2). When you select
an item, two translation fields appear in the common area.

When you select a grid item, the Space Used field displays the amount of space used for both the top and
bottom translation fields.

To translate grid items:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F79750: Forms Design Aid (FDA).

2. On Work with Forms Design Aid Text, complete these fields and click Find:
• Product Code
• Status
• Language
• Status Details
This option enables you to see all the details for the items in the detail area. To return to a summarized
view, clear this option.

3. Select an item in the detail area and click Select.
4. On the View tab, click a grid item in the menu tree.
5. Translate the item in the Target field.
6. Click OK.
When you select OK, the system saves the translation, updates the status, and displays the next item of the
chosen status in the Source data field.
When you select Save, the system saves the translation and updates the status, but does not move on to
the next item in the list.

Using Overrides
This section discusses how to:

• Use overrides.
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• Remove overrides.

Using Overrides
When an English override is applied to an item within an application, it means that a developer overrode a data
dictionary description and entered an alternate description.

When an item does not have an English override, the base data dictionary description automatically appears in
the Target field. Controls and grids within a form in an application correspond to a data dictionary item. If
development has not overridden the text, you should assign the data item the DD Default (status 15 FDA/RDA
DD Default) when you translate.

When an English override is applied to an item, the Text Overridden check box in the Text Information
group is selected in the Forms Design Aid Text form. In these cases, a language override is also applied
automatically. You cannot clear the Text Overridden check box when the English description was overridden.
The text must be translated because the DD Default cannot be used. Use the Suggestions option to ensure
consistent terminology when translating overridden items.

Note. When you change a default value for a data dictionary item, the change is made dynamically in every
instance of the software. Changes to overrides must be made to each individual instance.

Removing Overrides
If the base translation is not appropriate in the context of the application’s form, you have these options:

• Change the item to status 15 (FDA/RDA DD Default) to apply a language override. The new translation you
enter applies only to the item for that particular application.

• Apply an override theself. Use status 11 (Complete) to apply a language override. The new translation you
enter applies only to the item for that particular application.

• Remove a language override by changing the status to 11 (Complete). When you do this, PeopleSoft
Translation Tools display the data dictionary translation for you to review and replace as necessary.
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CHAPTER 8

Translating Reports

This chapter provides an overview of report translation and discusses how to:

• Translate report information.
• Use overrides.

Understanding Report Translation
This section discusses:

• Report translation.
• The report translation process.
• Report versions.
• The Report Design Aid (RDA) Translation Tool interface.

Report Translation
You create reports using the PeopleSoft application named Report Design Aid (RDA) Translation Tool.
Reports are generally referred to as Universal Batch Engines (UBEs) because they not only present data in
report form, but they also can be used to create batch programs that perform certain actions.

Reports are used to view trends, outcomes, and information from PeopleSoft applications. Reports can be
accessed from multiple PeopleSoft programs and menus. The report name begins with the letter R, followed
by the application name. For example, in the report name R01010Z, R indicates that it is a report and 01010Z
indicates that the report belongs to program P0101.

Use the Report Design Aid (RDA) Translation Tool to translate interface items of PeopleSoft reports from the
source language into the target language.

The Report Translation Process
You translate reports by selecting untranslated items within the assigned system. To translate report items:

1. Display the first report in the list.
2. Translate these items:
• Report title
• Page headers
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• Page details
• Columns

Note. Section titles do not need to be translated.

3. Save the changes.

When you save a translation, the PeopleSoft Translation Tool displays the next item of the chosen status.
Continue translating items until no untranslated items remain.

See Also
Chapter 14, “Understanding Jargon and Overrides,” Overrides and Jargon, page 87

Report Versions
Different versions of the same report often exist. The base report or template is marked with a plus sign (+),
and versions are usually named XJDE0001, XJDE0002, ZJDE0001, and so on.

A version is a user-defined set of specifications. These specifications control how applications and reports
run. You use versions to group and save a set of user-defined processing option values or data selection and
sequencing options. Interactive versions are associated with applications (usually as a task selection). Batch
versions are associated with batch jobs or reports. To run a batch process, you must select a version.

The Report Design Aid (RDA) Translation Tool Interface
The Report Design Aid (RDA) Translation Tool consists of these tabs: View, Audit, Tasks, Data Dictionary,
Glossary, and Processing Options.

Report Design Aid View Tab
On the View tab of the Report Design Aid Text form, you can display all of the items for the selected report
in a menu tree view. When you click an item in the tree, the current source term, the target term, and the
status appear in the data fields of the common area.

Report Design Aid Audit Tab
The Audit tab displays the selected statistics for items that are contained in the report. You cannot enter or
change any of the displayed items. The information in the common area remains the same as it appears
on the View tab.

Report Design Aid Tasks Tab
The Task tab lists the selected report’s tasks in a tree format for you to review. All of the entries are derived
from the database by the system and cannot be changed.

Report Design Aid Data Dictionary Tab
The Data Dictionary tab contains the selected report’s data items and user-defined codes (UDCs) in a menu
tree view. You cannot enter or change any of the displayed items.

Note. You can access the data dictionary translation tools to edit data dictionary and user-defined code
items from the RDA tools by double-clicking node from the data dictionary folder or by selecting DD from
the Form menu.
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Report Design Aid Glossary Tab
The Glossary tab contains the selected data item’s glossary text. The Glossary tab enables you to view the
glossary for the source and target language. You cannot edit the glossary from this tab. To edit the glossary,
select DD from the Form menu. In addition, the data field information in the common area remains the same
as it appears in the View tab.

Report Design Aid Processing Options Tab
On the Processing Options tab, you can view all of the selected report’s processing options items for translation
in the menu tree format.

Note. You can access the Processing Option text translation tool to edit processing option text from the RDA
tools by double-clicking a node from the Processing Options folder.

Translating Report Information
When you translate reports, you translate all of the items for that report, such as the report title, page headers,
page details, and columns.

To translate report information:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F79760: Report Design Aid (RDA).

2. On the Work with Report Design Aid Text form, complete these fields and click Find:
• Status
• Language
• (Optional) Program ID
This field is in the detail area.

3. Select an item in the detail area and click Select.
4. On the Report Design Aid Text form, select the View tab, and then click an item in the menu tree.
5. Enter the translation.
6. Click OK to save the translation.
When you click OK, the system saves the translation, updates the status, and displays the next item of the
chosen status in the Source data field.

Using Overrides
This section discusses how to:

• Use overrides.

• Remove overrides.
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Using Overrides
An English override that is applied to an item within an application means that a developer overrode a data
dictionary description and entered an alternate description.

When an item does not have an English override, the base data dictionary description automatically appears in
the target field. Controls and grids within a form in an application correspond to a data dictionary item. If
development has not overridden the text, you should assign the data item the DD Default (status 15 FDA/RDA
DD Default) when you translate.

When an English override is applied to an item, the Text Overridden check box in the Text Information
group is selected in the Forms Design Aid Text form. In these cases, a language override is also applied
automatically. You cannot clear the Text Overridden check box when the English description was overridden.
The text must be translated because the DD Default cannot be used. Use the Suggestions option to ensure
consistent terminology when translating overridden items.

Note. When you change a default value for a data dictionary item, the change is made dynamically in every
instance of the software. Changes to overrides must be made to each individual instance.

Removing Overrides
If the base translation is not appropriate in the context of the application’s form, you have these options:

• Change the item to status 15 (FDA/RDA DD Default) to apply a language override.
The new translation that you enter applies only to the item for that particular application.

• Apply an override theself.
Use status 11 (Complete) to apply a language override. The new translation that you enter applies only to
the item for that particular application.

• Remove a language override by changing the status to 11 (Complete). When you do this, PeopleSoft
Translation Tools display the data dictionary translation for you to review and replace as necessary.
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CHAPTER 9

Translating Solution Explorer Tasks

This chapter provides an overview of task translation and discusses how to translate task and menu items.

Understanding Task Translation
This section discusses:

• Task translation.
• The Solution Explorer task translation process.
• The Solution Explorer task translation tool.

Task Translation
Tasks are menu items and application names that appear in PeopleSoft software. The Solution Explorer task
translation tools display the menu name, followed by each application that appears when users select the
menu in PeopleSoft software.

You use these Solution Explorer tools to translate solution tasks:

• F9000: Solution Explorer Tasks.
• F9005: Solution Explorer Variant Tasks.
• F9006: Solution Explorer Variant Task Details.

The Solution Explorer Task Translation Process
To users, menus and tasks appear as lists, or trees, from which users select applications in PeopleSoft software.
These trees are multitiered, and often contain several levels of options. When you place the cursor over the
menu or application name, a definition appears. You must translate the name and its definition. In the Solution
Explorer Task translation tool, each tab name is followed by each object in a menu tree.

The Solution Explorer Task Translation Tool
You translate all menus and task items using the Solution Explorer task translation tool. In addition to
translating items, you can retrieve and use existing translations, check spelling, change the status of an item,
save translated items, search for and replace target text, and so forth.
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The Work With Task Translations Form
The entry point to the Solution Explorer task translation tool is the Work With Task Translations form. Use
this form to search for and select items that need to be translated. You can search for items using a variety of
search criteria, such as language, product code, and translation status.

The Task Translation Form
After you have selected an item from the Work With Task Translations form, the Task Translation form
appears. This form contains two tabs: View and Audit. Use these tabs to complete all translation requirements,
including changing translation status and viewing item history.

On the View tab, you can select an item to translate or edit by clicking in the menu tree. When you select an
item, the tool highlights the item and populates the source and target fields with the associated text.

The View tab displays a consolidated view of information for each menu or task item. Use this tab to perform
actual translations, change item status, view object information, and so on.

The Audit tab displays historical and statistical information for each menu or task item. You can review audit
information for a delta item to see who translated it last, its source, and so on. You do not need to check this
information as part of the daily translation process. However, it is a vital part of troubleshooting a problem
item caused by the translation tools or the delta process.

You can also translate the item that is currently displayed on this form, although you cannot translate additional
items.

Translating Menu or Task Items
The Solution Explorer task translation tools enable you to search for and display menu and task items by
various search criteria, including product code, language, status, task, or any combination of these criteria.
Searching for items using these criteria enables you to specify the menu and task items that are displayed.

Note. The Solution Explorer task translation tools retrieve the task items that match the search criteria and
display them in the detail area.

Any language that you search on that is not specified in the user profile is read-only.

If you leave any of the fields blank, the system uses the default value of * (asterisk), which equals a search
for all items.

To translate menu or task items:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F9005: Solution Explorer Variant
Tasks.

2. On the Work With Variant Description Translations form, complete any of these fields and click Find:

• Product Code

• Status
• Task View ID

• Language
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3. Select the item that you want to translate, and click Select.
The Variant Description Translation form appears.

4. Select an item from the menu tree.
5. Translate the item.
6. Click OK.
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CHAPTER 10

Translating User Defined Codes

This chapter provides an overview of user-defined code translation and discusses how to:

• Access items to translate.
• Review glossary information.
• Translate user-defined code items.

Understanding User Defined Code Translation
This section discusses:

• User-defined code translation.
• User-defined code translation tools.

User Defined Code Translation
Within PeopleSoft forms, users must often enter information into text fields. Many times, users can select
the information from a list of items called User Defined Codes (UDCs). UDCs are codes and descriptions
in PeopleSoft software that provide users with an easy way to select a value from a list. UDCs are stored in
tables within PeopleSoft software, and are accessed from these tables.

Each UDC contains a description of the option as well as a code for that option. Only the descriptions must be
translated; the codes remain the same in every language.

User Defined Code Translation Tools
User Defined Codes (UDCs) are stored in tables that contain at least one item and can hold an unlimited
number of items. The User Defined Code (UDC) translation tool displays all items in a table at once in
order for you to view them in context.

You translate all User Defined Codes (UDCs) from the PeopleSoft UDC translation tools. In addition to
translating items, you can retrieve and use existing translations, check spelling, change the status of an item,
save translated items, search for and replace target text, and view glossary definitions.

You use two tools to translate UDCs. You select which tool to use based on what you want to translate.
The function of each tool is as follows:

• F0004: User Defined Code (UDC) Types
Use this tool if you are translating only UDC Types. UDC Types are the actual code table titles.

• F0005: User Defined Codes (UDC)
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Use this tool if you are translating only the UDC Codes or want to see all untranslated UDC items. This tool
displays all the UDC Codes as well as the associated UDC Types, regardless of their translation status.

Both of these tools function similarly. However, if you decide to start translating using the F0005: User
Defined Codes (UDC) tool, you must use the F0004: User Defined Code (UDC) Types tool to verify that you
have translated all UDC Types. You must do this because the UDC Code tool does not display any untranslated
code types if no untranslated UDC Codes exist. Both of the UDC translation tools consist of the Work With
User Defined Code Type Language Translation form and the User Defined Codes Translation form.

Work With User Defined Code Type Language Translation Form and Work With User
Defined Code Language Translation Form
The entry points to the User Defined Code (UDC) Translation tool are either the Work With User Defined
Code Type Language Translation form or the Work With User Defined Code Language Translation form. Use
these forms to search for and select items that you want to translate. You can search for items using various
search criteria, such as language, product code, translation status, and UDC types.

You use these four data fields to search for UDC items to translate:

• Product Code
• Language (L)
• Status
• UDC Types

These data fields enable you to specify the limits to be used in selecting the items to be translated. The most
restrictive specification is a specific code in each data field; the least restrictive specification is the wild
card * (asterisk) in a data field.

User Defined Codes Translation Form
After you have chosen an item from the Work With User Defined Code Type Language Translation form or
the Work With User Defined Code Language Translation form, the User Defined Codes Translation form
appears. This form contains these tabs: View, Glossary, and Audit. Use these tabs to complete all translation
requirements, including changing translation status, comparing glossary content, and viewing item history.

Accessing Items to Translate
You select items to translate from the View tab. The View tab displays a consolidated view of information for
each UDC item. The tree view displays all items according to the item you selected on the "Work With?" form.
The information that is displayed depends on the display options you select. You can use the View tab to select
text for translation, perform actual translations, change item status, view object information, and so forth.

To select an item from the tree:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F0005: User Defined Codes (UDC).

2. On Work With User Defined Code Language Translation, complete these fields and click Find:

• Product Code

• Status
• Language
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• UDC Types
3. Click the item in the detail area that you want to translate, and click Select.
The User Defined Codes Translation form appears with the item you chose displayed in the Tree view.

4. In the menu tree, click the item you want to review or translate.
When you select an item, the system populates these fields:
• UDC Type
• UDC Code
• Source
The Source fields always populate with the source text.

• Target
The Target fields only populate when a translation exists.

Reviewing Glossary Information
UDCs can be associated with data items. The Glossary tab contains information that describes that data
dictionary item.

To review glossary information for UDCs:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F0005: User Defined Codes (UDC).

2. On Work With User Defined Code Language Translation, locate the user defined code records that you
want to translate.

3. Select an item in the detail area and click Select.
4. Select an item from the tree menu.
5. On User Defined Codes Translation, select an item and click the Glossary tab.
6. Review the glossary.
The Glossary tab form contains information assigned to a data dictionary item. Use it to make contextual
comparisons in order to accurately translate an item. You can translate the item currently displayed on
this form, although you cannot translate additional items. You translate the glossary using the Data
Dictionary Language Translation program (P799201).

Translating User Defined Code Items
You have three options when translating user defined code items: you can enter translations manually, copy
the source item, or use the suggestion process. This section provides an overview of space constraints and
discusses how to:

• Enter translations manually.
• Copy the source item.
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Understanding Space Constraints
A fixed amount of space is available for the translated text of each item. Because translated text usually
requires more space for most target languages, you might have to abbreviate the translations.

Entering Translations Manually
To enter a translation manually:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F0005: User Defined Codes (UDC).

2. On Work With User Defined Code Language Translation, locate the user defined code records that you
want to translate.

3. Select an item and click Select.
The User Defined Codes Translation form appears, displaying the source term in the Source field.

4. In the Target field, enter the translated text.
5. Click OK.
When you click OK, PeopleSoft translation tools saves the translation and updates the status. You have to
click Next to move to the next untranslated item.

Copying the Source Item
To copy the source item:

1. From the Translation Applications menu (GH791), select either Senior Translations or Junior Translations,
depending on whether you are a senior or junior translator, and then F0005: User Defined Codes (UDC).

2. On Work With User Defined Code Language Translation, locate the user defined code records that you
want to translate.

3. Select an item in the detail area, and then click Select.
The User Defined Codes Translation form appears, displaying the source item in the Source field.

4. Select a record in the menu tree.
5. On the toolbar of the form, click Form and then click the Copy Source option.
The source item appears in the Target field.

6. Click OK to save the translation.
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Translating Across Multiple Releases
or Environments

This chapter provides an overview of translation for multiple releases and discusses how to match criteria for
updates and audits in the Multiple Release Exact Match program (P7903).

Understanding Translation for Multiple Releases
You might have to translate more than one release at a time if you translated in these situations:

• In a prior release and the translations need to be matched in a current release.

• In the current release and you want to leverage those translations again.

• In the current release and the translations need to be matched in a prior release.

The Multiple Release Exact Match program (P7903) uses source text to locate target text with the same
text strings. Using the Multiple Release Exact Match program across multiple releases or environments
has these benefits:

• Ensures no disconnect between source and target text.
• Provides cost-effective budgeting of language assets.
• Provides consistent terminology.
• Eliminates production time for matching text.
• Accelerates the quality assurance process.

Matching Criteria for Updates and Audits in the Multiple
Release Exact Match Program (P7903)

This section provides an overview of matching criteria and discusses how to translate across multiple releases
or environments.

Understanding Matching Criteria
The Multiple Release Exact Match program (P7903) requires specific matching criteria to update status, audit
trail, and target translations. This table documents those criteria and what the program does when it finds or
does not find the specified criteria. The table also lists which source and target translation items it uses when
matching them for updates and for creating audit trails.
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Criteria Program Response

Reports and Forms (Data Dictionary Verification and
Status Update)

Data Dictionary Verification

The program verifies the source data dictionary items
against the Data Field Display Text table (F9202)
translations to ensure that a data item name exists but no
text overrides exist.

Data Dictionary Status Update

If the program finds a data item name and no text override,
it updates the data dictionary status to 15 (DD Default)
when you run the Multiple Release Exact Match program
in final mode.

Source If the program detects blank source items, the status of the
item is updated to Skip (30) when you run the Multiple
Release Exact Match program in final mode.

Primary Source Text The program always matches the primary source text
against the text in the secondary search environment.

Primary Source and Status The primary source text and status must exist, and the
program always verifies against the primary target.

Secondary Source The secondary source, status, and target must exist for an
exact match.

Status Verification TheMultiple Release Exact Match program verifies
whether the:

• Primary pate translated is a null (does not exist) date.

• Secondary date translated is greater than or equal to the
primary date translated.

• Primary target is null (does not exist) or blank.

• Secondary complete status is equal to the secondary
search complete status.

Audit Trail In the Primary Update Code Page Environment, the Audit
Trail information updates the:

• Last translator to XTRANS (use XTRANS with
Search/Replace & Review Approved).

• Date translated to secondary last date translated.

• User, PID, job, date, and time to the current audit
information.

• Primary Selection Status (20) to Primary Update Status
(36)

Translating Across Multiple Releases or Environments
You must be a senior translator to run the Multiple Release Exact Match program (P7903).

To translate across multiple releases or environments:
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1. From the Translation Applications menu (GH791), select Exact Match Quality Assurance, and then
Translation Tools.

2. On the PeopleSoft Translation Tools form, from the Form menu, select Exact Match.
3. Complete the criteria in these categories:
• Language
You can change languages to submit more than one language.

• Mode
You can run the process in Preliminary or Final mode.

• Preliminary
The system does not update records. It only reports the total number of records.

• Final
The system updates records to the primary compare and code page environments.

Note. You should run the Exact Match process in Preliminary mode first. Preliminary mode enables you
to verify the record totals.

• Selection Filter
• Primary Product Code
You use the primary product code in conjunction with the status selection in the primary compare
environment to define a record set.

Note. You should repeat the process for each individual product code. If you do not enter a value in the
Primary Product Code field, the system searches all product codes for matching records.

• Status
• Primary Selection Status

The record status that the system selects from primary environment. This value is typically 20
(Untranslated).

• Secondary Complete Status

The record status that the system matches against the selection status in the secondary environment.
This value is typically 11 (Complete).

• Primary Update Status

The record status that the system uses to update records in the primary environment. This value is
typically 36 (Exact Match).

• Primary Skip Status

The record status that the system uses to update blank records in the primary environment. This value
is typically 30 (Skip).

• Compare Environments

• Primary Update

The compare environment that the system uses to select and update matching records that it finds from
the secondary environment.
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• Secondary Search
The compare environment that the system uses to verify the secondary complete status and the source
text of the match type.

• Code Page Environments
• Primary Update
In Final mode, the code page environment from which the system updates the secondary code page
environment after a match is found.

• Secondary Search
Once the match is found the secondary compare environment, the code page data that the system uses
to update the primary environment.

• Match Type
• None
No match is required.

• Source and Key
The source and the primary key of each table must match.

• Source and Product Code
The source term and product code must match.

• Source
Same term (Default) must match but in any product code. It does not have to be the product code that
you specified in the Primary Product Code field.

4. In the detail area, select the tables to include in the exact match process.
From the Form menu, select one of these options:
• Yes
Include all tables in the exact match process.

• No
Exclude all tables from the exact match process. This selection clears all tables from the process so that
you can select only those that you want.
Alternatively, you can include or exclude tables from the exact match process by double-clicking a cell in
the Include column and typing one of these values:

• 1
Include the table in the exact match process.

• 0
Exclude the table in the exact match process.

5. From the Form menu, select Submit.
Alternatively, you can click the Submit button on the header of the form.
Clicking Submit runs the Multiple Release Exact Match batch process (R79850) and produces a report.

After you run the Exact Match process in Final mode, you should review and approve the results.
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CHAPTER 12

Quick Reference for Product Codes

This chapter provides an overview of PeopleSoft EnterpriseOne product codes and discusses how to locate
a complete list of the codes.

Product Codes
This table displays some of the product codes for the PeopleSoft verticals and their systems. For an up-to-date
and comprehensive list, see user defined code (98/SY).

Product Code Description

00 Foundation Environment

01 Address Book

02 Electronic Mail

03 Accounts Receivable

03B Enhanced Accounts Receivable

03C Issue Management System

0301 Credit Management

04 Accounts Payable

05 Time Accounting/HRM Base

05A PeopleSoft HR & PR Foundation

05C PeopleSoft HR & PR Foundation - Canadian

05T Time Entry

05U PeopleSoft HR & PR Foundation - US

06 Payroll

07 Payroll

07S Payroll SUI
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Product Code Description

07Y US Payroll Year End

08 Human Resources

08B Benefits Administration

08C PeopleSoft HR Canadian

08H Health and Safety

08P Position Control

08R Recruitment Management

08U PeopleSoft HR - US

08W Wage and Salary

09 General Accounting

09E Expense reimbursement (ERS)

10 Financial Reporting

10C Multi-Site Consolidations

11 Multi-Currency/Euro

11C Cash Basis

12 Fixed Assets

13 Equipment Plant Management

14 Modeling, Planning, Budgeting

15 Property Management

16 Profit Management (EPS)

17 Customer Service Management System

17A Ariba Integration

17C Call Management (part of CSMS)

17X Travel & Expense Mgt Powered by Extensity

18 TimeManagement

19 Utility CIS

20 Energy base

74 PeopleSoft Proprietary and Confidential



Chapter 12 Quick Reference for Product Codes

Product Code Description

21 Lease Management

2101 MTI Electrical Distribution

22 Production

23 Revenue Distribution

24 Gas Contracts

25 Joint Interest Billing

26 Gas Balancing

27 Investor Services

29 AFE Accounting

30 Product Data Management

30A Product Costing

3010 Process Data Management

31 Shop Floor Management

31A Manufacturing Accounting

3110 Process Control

32 Sales Configurator

32C CustomWorks Configurator

33 Capacity Planning

34 Requirements Planning

34A Advanced Planning & Scheduling (APS)

35 Enterprise Facility Planning

36 Forecasting

37 Quality Management

38 Agreement Management

39 Advanced Stock Valuation

40 Inventory/OP Base

4010 Advanced Price Adjustment
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Product Code Description

41 Inventory Management

41B Bulk StockManagement

42 Sales Management

42A Lead Opportunity Management

42B Sales Order Entry

42E ECS Sales Management

43 Procurement

44 Subcontract Management

44H Homebuilder Management

4401 Homebuilder Management

45 Advanced Pricing

46 Warehouse Management

47 Electronic Commerce

48 Work Order Processing

48S Service Billing

49 Transportation Management

50 Job Cost Base

51 Job Costing (Job Cost Accounting)

52 Contract Billing

53 Change Management

55-59 Reserved for Clients

60-69 Reserved for Custom

70 Multi-National Products

71 Client Server Applications

72 WorldVision

73 M&DComplementary Products

74 EMEA Localization
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Product Code Description

74H Hungary

74I Ireland

74L Portugal

74M Denmark Localization

74N Nordics Localization

74O Norway Localization

74P Poland Localization

74R Russian

74S Spain Localization

74T Turkey

74W Sweden Localization

74Z Czech Republic

75 ASEAN Localization

75A Australian Payroll

75C China

75H Thailand Localization

75I India

75K Korea Localization

75N New Zealand

75T Taiwan Localization

75Z New Zealand Localization

76 Latin American Localization

76A Argentina Localization

76B Brazil

76C Columbia Localization

76H Chile Localization

76M Payroll (Mexico)
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Product Code Description

76P Peru Localization

76V Venezuela Localization

77 Canadian Payroll

77Y Canada Payroll Year End

79 Translation Tools

80 Business Intelligence

81 DREAMWriter (PeopleSoft World software only)

82 World Writer

83 Management Reporting - FASTR

84 Distributive Data Processing

85 Custom Programming

86 Electronic Doc. Interchange

87 Internal

88 Cautious Purge System

89 Conversion Programs

91 Documentation

92 Computer Assisted Design

93 Computer Assisted Programming

94 Security Officer

95 Sleeper

96 Computer Operations

96P NO INFO ON THIS SYSTEM

97 Software Installation

98 Technical Tools

98E Electronic Burst and Bind

98FT Form Type

98SA Sample Application
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Product Code Description

99 Technical Tools-Internal

99D Technical Tools-DASD Sizer (reporting syst. only)

99M Technical Tools-Masters/Update (reporting syst. only)

99P NO INFOON THIS SYSTEM

D3N dcLINK (data collection)

H00 Foundation (UDC only)

H01 Address Book (incl. ALL mail)

H03 Accounts Receivable

H03B New Accounts Receivable

H04 Accounts Payable

H05 Standalone Time Accounting

H07 Payroll

H08 Human Resources

H09 General Accounting

H12 Fixed Assets

H13 Plant/Equipment Mgmt

H15 Commercial Property Management

H30 Product Data Management

H301 Process Data Management

H31 Shop Floor Management

H311 Process Control

H32 Configuration Management

H33 Capacity Requirements Planning

H34 DRP/MRP/MPS

H35 Enterprise Facility Planning

H36 Advanced Forecasting

H40 Inventory/OP Base
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Product Code Description

H41 Inventory Management

H415 Bulk Inventory Management

H42 Sales Order Processing

H43 Procurement

H44 Contract Management

H44H Homebuilder Management

H45 Sales Analysis

H46 Warehouse Management

H50 Job Cost Base

H72 Client/Server Base

H73 Client Service - A/P Voucher Entry

H74 CS - Pay Time Entry

H75 CS - Sales Order Entry

H76 CS - Training & Development

H78 CS - Travel Expense Management

H79 Translation Tools

H90 PeopleSoft Tools

H91 Design Tools

H92 Interactive Engine / OL

H93 Data Base and Communications

H94 Batch Engine

H95 Technical Resources/Applications

H96 Deployment

H97 Automated Testing Tools

H98 Internet

H99 Product Version Control

H99P Technical Tools-OWPVC Internal
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Product Code Description

JE42 Sales Order/Pricing (ECS Enhancements)

JE44 Distribution Contracts (ECS Enhancements)

JE48 Automated Gantry Inter. (ECS Enhancements)
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CHAPTER 13

Quick Reference for Status Codes

This chapter provides an overview of status codes and discusses how to use status codes during the translation
process.

Status Codes
Status codes identify the status that is associated with a text item. The status enables editors and translators
to make changes according to the change type. Translation tools use three types of status codes to help you
identify where items are in the translation process.

• Status
• Reason
• Skip

Status Codes
This table describes some of the status codes that you can use. For an up-to-date and comprehensive list,
see the H79/TS user-defined code list.

Numeric Status Code Description

01 Not Translated. Assign this status to source terms that you
cannot translate into the target language.

11 Complete. After you have translated an item and saved it,
you must change its status to complete. All translation tools
automatically change the status to Complete when you save
the translation using the Senior Translations version.

Only items with a Complete (11) or Edit/Review (25)
status appear in the final translated software. Therefore, it
is extremely important that you save each translation and
make sure that the status changes to Complete.

15 Data Dictionary Default. The Forms Design Aid (FDA)
and Report Design Aid (RDA) translation tools use this
status code.

20 Untranslated. This is the untranslated status for all items in
PeopleSoft software.
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Numeric Status Code Description

25 Edit (Review). In the Junior Translations version, the
system changes the status to Edit when you press OK.
When another translator edits the translation and finalizes
it, the system changes the status to Complete (11).

30 Other (Skip Reason). Use the Skip Reason status to force
the source text to appear in the application.

60: The item contains test data.

61: Unnecessary for all languages.

62: Unnecessary for this language.

64: Waiting for application development.

35 Translation Memory. The item has been exported to a
translation memory and then reimported to PeopleSoft
software.

99 Purge from System. The Delta Process automatically
assigns this status; the user never assigns this status.

Reason Codes
Reason codes define the change to the text. Many items will be set to untranslated with a type of new item.
This table lists reason codes. For an up-to-date and comprehensive list, see the H79/CT user-defined code list.

Numeric Status Code Description

40 New Item

41 Text and Size Change

42 Text change

43 Minor Text Change

44 Size Change

Skip Codes
The Skip Reason status enables the editor or translator to assign the reason for skipping a text edit. This table
lists skip codes. For an up-to-date and comprehensive list, see the H79/SR user-defined code list.

Numeric Status Code Description

00 Normal

60 Test Data. The item contains test data.

61 Unnecessary for all languages.
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Numeric Status Code Description

62 Unnecessary for this language. The item is specific to the
U.S. or Canada.

63 Waiting for application developer.

64 Insufficient Length. The translation does not fit in the
allotted space.
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CHAPTER 14

Understanding Jargon and Overrides

This chapter provides an overview of overrides and jargon and discusses how programmers create them.

Overrides and Jargon
The use of overrides and jargon is the most complex aspect of translating PeopleSoft software. Jargon and
overrides are features that apply to the Data Dictionary (DD), Forms Design Aid (FDA), and Report Design
Aid (RDA) translation tools.

Jargon and overrides tell the software what type of information should appear in certain situations. Developers
apply jargon when modifying items within the data dictionary, and they apply overrides when modifying
the descriptions that appear on forms.

You might see different text on a form if you run it from the Fast Path field instead of running it from a task.

Developers must define different field descriptions on the same form depending on how the programs are
called. For example, program P1234 calls form W1234A, which has a field description abc. If another
program calls form W1234A, for example P5678, then form W1234A displays this field description as xyz
instead of abc. This table illustrates this concept:

Program Called Form Displayed Data Item

P1234 W1234A abc

P5678 W1234A xyz

According to programming standards, programmers must program jargon and overrides without using event
rules (ER). Runtime engines run the ER. When you run a program from the Fast Path field, the runtime
engines run this ER.

To understand jargon and overrides, you must first understand the data dictionary.

PeopleSoft Proprietary and Confidential 87



Understanding Jargon and Overrides Chapter 14

88 PeopleSoft Proprietary and Confidential



CHAPTER 15

Understanding the Data Dictionary

This chapter discusses:

• The data dictionary.
• Data dictionary jargon.
• Form design aid (FDA) overrides.

The Data Dictionary
The data dictionary (DD) stores the descriptions for all the controls, text fields, buttons, F1 help, and other
items that appear on forms in PeopleSoft software. Each data dictionary item contains four descriptions: alpha
description, row description, column description, and glossary.

• Alpha description.
The alpha description is the title of the F1 help in PeopleSoft software, which is the glossary entry in
the software.

• Row description.
When a data dictionary item is used as a control, such as a field, check box, or radio button, the row
description is used as the text for the control.

• Column description.
When the data dictionary item is used as a grid item, such as a column heading in a report or form, the
column description is used as the text for the grid item.

• Glossary.
The glossary is the help text that appears when a user presses F1. It explains what a field in a form means or
how it is used in the software. The alpha description appears as the title of the help text.

Data Dictionary Jargon
This section discusses:

• Jargon fundamentals.
• Alpha jargon.
• Row and column jargon.
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Jargon Fundamentals
Each data dictionary item can be used on many different forms. As developers use and reuse data dictionary
items, they can modify the descriptions for the items. To do this, they apply jargon. Jargon enables developers
to customize data dictionary text so that an alternate description appears, depending on the context and
system code in which the item is used.

Developers can apply two types of jargon to data dictionary items:

• Alpha and glossary

• Row and column

Jargon is applied to form controls and grid items when the data dictionary default value is used. Using the
data dictionary is always preferred because terminology changes can be managed through the data dictionary
instead of a form-by-form vocabulary override basis. When a translator overrides the item with a specific
translation, jargon can no longer be applied. In the case that jargon does not exist, you should work with
content developers or product experts to add new jargon terminology to the data dictionary so that the proper
jargon translation can be applied during runtime processing.

Note. If you create an override for a translation item, that translation item is static and cannot be used
dynamically anywhere else. You will have to maintain overrides individually. Therefore, you should use the
data dictionary default values whenever possible.

Alpha Jargon
When a new glossary entry, or F1 help, is applied to an item, the developer changes the alpha description
because it is the title of the F1 help. In these instances, a developer would apply alpha jargon.

Alpha jargon can apply to individual forms or entire systems. For instance, when a data dictionary item is used
in the same context throughout an entire system, the developer would apply system-level alpha jargon. When
an item is used in a different context in only one form, the developer would apply form-level alpha jargon.

In this example, the data item AN8 has both system-level jargon (identified by 12, 15, 19, and so on in the
Product Code Reporting column) and form-level jargon (identified by W03013B, W0401A, W0474N3B,
and so on in the ScrnRpt Name column) applied.

Row and Column Jargon
Developers apply row and column jargon when they want a description other than the base description to
appear on a form. Row and column jargon can apply only to entire systems.

For example, the base description for the data dictionary item AN8 is Address Book Number. When the data
item is used without any jargon, the system displays it as Address Number.

However, when used in Product Code 42 (Sales Management), the item is more appropriately described
as Sold To.

The new description, Sold To, is a new data dictionary item. This new item appears as Product Code 00 with a
reporting code of 42. In this instance, all forms in system 42 that contain the data dictionary item AN8 will
display Sold To.

When you translate row and column jargon, the DD translation tool updates the status of each form item in
which the jargon data dictionary item is used to DD Default (status = 15). When you begin translating forms,
you must search for all items with a DD Default (status = 15) and verify that the translation fits in the allotted
space on the individual forms.

90 PeopleSoft Proprietary and Confidential



Chapter 15 Understanding the Data Dictionary

FDA Overrides
Overrides are similar to jargon except that they occur at the form level. The two types of FDA overrides are
English and Translation. This section discusses:

• English overrides.

• Language overrides.

English Overrides
PeopleSoft forms can be reused in multiple systems. In these cases, developers apply English overrides to
data dictionary items and enter alternate descriptions. Developers can apply English overrides to specific
forms but not to entire systems.

For example, when a form is called from system 30, a text field might be described as Customer Number.
When called from system 31, the same text field might be described as Address Book Number. When you
translate the forms in system 30, you will see only the description Customer Number.

When an English override exists, the translation is automatically overridden.

Note. In the FDA Translation Tool, you can view the items that have overrides. Items that have overrides have
a check mark in the Text Overridden check box.

Language Overrides
As a translator, you can enter a language override when the description of an item does not fit the context of
the form. A translation override applies only to the item as it is used on a particular form. Although these
circumstances might require language overrides, use language overrides sparingly:

• The data dictionary translation does not fit in the allotted space in a form.
• The data dictionary translation is not appropriate for the context.

PeopleSoft Proprietary and Confidential 91



Understanding the Data Dictionary Chapter 15

92 PeopleSoft Proprietary and Confidential



Glossary of PeopleSoft Terms

activity A scheduling entity in PeopleSoft EnterpriseOne Form Design Aid that represents a
designated amount of time on a calendar.

activity rule The criteria by which an object progresses from one given point to the next in a flow.

add mode A condition of a form that enables users to input data.

Advanced Planning Agent
(APAg)

A PeopleSoft EnterpriseOne tool that can be used to extract, transform, and load
enterprise data. APAg supports access to data sources in the form of rational databases,
flat file format, and other data or message encoding, such as XML.

application server A server in a local area network that contains applications shared by network clients.

as if processing A process that enables you to view currency amounts as if they were entered in a
currency different from the domestic and foreign currency of the transaction.

alternate currency A currency that is different from the domestic currency (when dealing with a
domestic-only transaction) or the domestic and foreign currency of a transaction.

In PeopleSoft EnterpriseOne Financial Management, alternate currency processing
enables you to enter receipts and payments in a currency other than the one in which
they were issued.

as of processing A process that is run as of a specific point in time to summarize transactions up to that
date. For example, you can run various PeopleSoft EnterpriseOne reports as of a
specific date to determine balances and amounts of accounts, units, and so on as of
that date.

back-to-back process A process in PeopleSoft EnterpriseOneWorkflowManagement that contains the same
keys that are used in another process.

batch processing A process of transferring records from a third-party system to PeopleSoft
EnterpriseOne.

In PeopleSoft EnterpriseOne Financial Management, batch processing enables you to
transfer invoices and vouchers that are entered in a system other than EnterpriseOne
to PeopleSoft EnterpriseOne Accounts Receivable and PeopleSoft EnterpriseOne
Accounts Payable, respectively. In addition, you can transfer address book
information, including customer and supplier records, to PeopleSoft EnterpriseOne.

batch server A server that is designated for running batch processing requests. A batch server
typically does not contain a database nor does it run interactive applications.

batch-of-one immediate A transaction method that enables a client application to perform work on a client
workstation, then submit the work all at once to a server application for further
processing. As a batch process is running on the server, the client application can
continue performing other tasks.

See also direct connect and store-and-forward.

business function A named set of user-created, reusable business rules and logs that can be called
through event rules. Business functions can run a transaction or a subset of a
transaction (check inventory, issue work orders, and so on). Business functions
also contain the application programming interfaces (APIs) that enable them to be
called from a form, a database trigger, or a non-EnterpriseOne application. Business
functions can be combined with other business functions, forms, event rules, and other
components to make up an application. Business functions can be created through
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event rules or third-generation languages, such as C. Examples of business functions
include Credit Check and Item Availability.

business function event rule See named event rule (NER).

business view Ameans for selecting specific columns from one or more PeopleSoft EnterpriseOne
tables whose data is used in an application or report. A business view does not select
specific rows, nor does it contain any actual data. It is strictly a view through which
you can manipulate data.

central objects merge A process that blends a customer’s modifications to the objects in a current release
with objects in a new release.

central server A server that has been designated to contain the originally installed version of the
software (central objects) for deployment to client computers. In a typical PeopleSoft
EnterpriseOne installation, the software is loaded on to one machine—the central
server. Then, copies of the software are pushed out or downloaded to various
workstations attached to it. That way, if the software is altered or corrupted through its
use on workstations, an original set of objects (central objects) is always available
on the central server.

charts Tables of information in PeopleSoft EnterpriseOne that appear on forms in the
software.

connector Component-based interoperability model that enables third-party applications and
PeopleSoft EnterpriseOne to share logic and data. The PeopleSoft EnterpriseOne
connector architecture includes Java and COM connectors.

contra/clearing account A general ledger account in PeopleSoft EnterpriseOne Financial Management that
is used by the system to offset (balance) journal entries. For example, you can use a
contra/clearing account to balance the entries created by allocations in PeopleSoft
EnterpriseOne General Accounting.

Control TableWorkbench An application that, during the installationWorkbench processing, runs the batch
applications for the planned merges that update the data dictionary, user-defined
codes, menus, and user override tables.

control tables merge A process that blends a customer’s modifications to the control tables with the data that
accompanies a new release.

cost assignment The process in PeopleSoft EnterpriseOne Advanced Cost Accounting of tracing or
allocating resources to activities or cost objects.

cost component In PeopleSoft EnterpriseOneManufacturing Management, an element of an item’s
cost (for example, material, labor, or overhead).

cross segment edit A logic statement that establishes the relationship between configured item segments.
Cross segment edits are used to prevent ordering of configurations that cannot be
produced.

currency restatement The process of converting amounts from one currency into another currency, generally
for reporting purposes. You can use the currency restatement process, for example,
when many currencies must be restated into a single currency for consolidated
reporting.

database server A server in a local area network that maintains a database and performs searches
for client computers.

Data SourceWorkbench An application that, during the InstallationWorkbench process, copies all data sources
that are defined in the installation plan from the Data Source Master and Table and
Data Source Sizing tables in the Planner data source to the System-release number data
source. It also updates the Data Source Plan detail record to reflect completion.
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date pattern A calendar that represents the beginning date for the fiscal year and the ending date for
each period in that year in standard and 52-period accounting.

denominated-in currency The company currency in which financial reports are based.

deployment server A server that is used to install, maintain, and distribute software to one or more
enterprise servers and client workstations.

detail information Information that relates to individual lines in PeopleSoft EnterpriseOne transactions
(for example, voucher pay items and sales order detail lines).

direct connect A transaction method in which a client application communicates interactively and
directly with a server application.

See also batch-of-one immediate and store-and-forward.

Do Not Translate (DNT) A type of data source that must exist on the iSeries because of BLOB restrictions.

dual pricing The process of providing prices for goods and services in two currencies.

edit code A code that indicates how a specific value for a report or a form should appear or be
formatted. The default edit codes that pertain to reporting require particular attention
because they account for a substantial amount of information.

edit mode A condition of a form that enables users to change data.

edit rule Amethod used for formatting and validating user entries against a predefined rule
or set of rules.

Electronic Data Interchange
(EDI)

An interoperability model that enables paperless computer-to-computer exchange of
business transactions between PeopleSoft EnterpriseOne and third-party systems.
Companies that use EDI must have translator software to convert data from the EDI
standard format to the formats of their computer systems.

embedded event rule An event rule that is specific to a particular table or application. Examples include
form-to-form calls, hiding a field based on a processing option value, and calling a
business function. Contrast with the business function event rule.

EmployeeWork Center A central location for sending and receiving all PeopleSoft EnterpriseOne messages
(system and user generated), regardless of the originating application or user. Each
user has a mailbox that contains workflow and other messages, including Active
Messages.

enterprise server A server that contains the database and the logic for PeopleSoft EnterpriseOne
or PeopleSoft World.

EnterpriseOne object A reusable piece of code that is used to build applications. Object types include tables,
forms, business functions, data dictionary items, batch processes, business views,
event rules, versions, data structures, and media objects.

EnterpriseOne process A software process that enables PeopleSoft EnterpriseOne clients and servers to
handle processing requests and run transactions. A client runs one process, and servers
can have multiple instances of a process. PeopleSoft EnterpriseOne processes can also
be dedicated to specific tasks (for example, workflow messages and data replication)
to ensure that critical processes don’t have to wait if the server is particularly busy.

EnvironmentWorkbench An application that, during the InstallationWorkbench process, copies the
environment information and Object Configuration Manager tables for each
environment from the Planner data source to the System-release number data source. It
also updates the Environment Plan detail record to reflect completion.

escalation monitor A batch process that monitors pending requests or activities and restarts or forwards
them to the next step or user after they have been inactive for a specified amount of
time.
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event rule A logic statement that instructs the system to perform one or more operations based
on an activity that can occur in a specific application, such as entering a form or
exiting a field.

facility An entity within a business for which you want to track costs. For example, a facility
might be a warehouse location, job, project, work center, or branch/plant. A facility is
sometimes referred to as a business unit .

fast path A command prompt that enables the user to move quickly among menus and
applications by using specific commands.

file server A server that stores files to be accessed by other computers on the network. Unlike
a disk server, which appears to the user as a remote disk drive, a file server is a
sophisticated device that not only stores files, but also manages them and maintains
order as network user request files and make changes to these files.

final mode The report processing mode of a processing mode of a program that updates or
creates data records.

FTP server A server that responds to requests for files via file transfer protocol.

header information Information at the beginning of a table or form. Header information is used to identify
or provide control information for the group of records that follows.

interface table See Z table.

integration server A server that facilitates interaction between diverse operating systems and applications
across internal and external networked computer systems.

integrity test A process used to supplement a company’s internal balancing procedures by locating
and reporting balancing problems and data inconsistencies.

interoperability model Amethod for third-party systems to connect to or access PeopleSoft EnterpriseOne.

in-your-face-error In PeopleSoft EnterpriseOne, a form-level property which, when enabled, causes the
text of application errors to appear on the form.

IServer service Developed by PeopleSoft, this internet server service resides on the web server and is
used to speed up delivery of the Java class files from the database to the client.

jargon An alternative data dictionary item description that PeopleSoft EnterpriseOne or
People World displays based on the product code of the current object.

Java application server A component-based server that resides in the middle-tier of a server-centric
architecture. This server provides middleware services for security and state
maintenance, along with data access and persistence.

JDBNET A database driver that enables heterogeneous servers to access each other’s data.

JDEBASE Database
Middleware

A PeopleSoft proprietary database middleware package that provides
platform-independent APIs, along with client-to-server access.

JDECallObject An API used by business functions to invoke other business functions.

jde.ini A PeopleSoft file (or member for iSeries) that provides the runtime settings required
for EnterpriseOne initialization. Specific versions of the file or member must reside
on every machine running PeopleSoft EnterpriseOne. This includes workstations
and servers.

JDEIPC Communications programming tools used by server code to regulate access to the
same data in multiprocess environments, communicate and coordinate between
processes, and create new processes.
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jde.log The main diagnostic log file of PeopleSoft EnterpriseOne. This file is always located
in the root directory on the primary drive and contains status and error messages from
the startup and operation of PeopleSoft EnterpriseOne.

JDENET PeopleSoft proprietary communications middleware package. This package is a
peer-to-peer, message-based, socket-based, multiprocess communications middleware
solution. It handles client-to-server and server-to-server communications for all
PeopleSoft EnterpriseOne supported platforms.

LocationWorkbench An application that, during the InstallationWorkbench process, copies all locations
that are defined in the installation plan from the Location Master table in the Planner
data source to the System data source.

logic server A server in a distributed network that provides the business logic for an application
program. In a typical configuration, pristine objects are replicated on to the logic
server from the central server. The logic server, in conjunction with workstations,
actually performs the processing required when PeopleSoft EnterpriseOne andWorld
software runs.

MailMergeWorkbench An application that merges Microsoft Word 6.0 (or higher) word-processing
documents with PeopleSoft EnterpriseOne records to automatically print business
documents. You can use MailMerge Workbench to print documents, such as form
letters about verification of employment.

master business function (MBF) An interactive master file that serves as a central location for adding, changing, and
updating information in a database. Master business functions pass information
between data entry forms and the appropriate tables. These master functions provide a
common set of functions that contain all of the necessary default and editing rules for
related programs. MBFs contain logic that ensures the integrity of adding, updating,
and deleting information from databases.

master table See published table.

matching document A document associated with an original document to complete or change a transaction.
For example, in PeopleSoft EnterpriseOne Financial Management, a receipt is the
matching document of an invoice, and a payment is the matching document of a
voucher.

media storage object Files that use one of the following naming conventions that are not organized into
table format: Gxxx, xxxGT, or GTxxx.

message center A central location for sending and receiving all PeopleSoft EnterpriseOne messages
(system and user generated), regardless of the originating application or user.

messaging adapter An interoperability model that enables third-party systems to connect to PeopleSoft
EnterpriseOne to exchange information through the use of messaging queues.

messaging server A server that handles messages that are sent for use by other programs using a
messaging API. Messaging servers typically employ a middleware program to perform
their functions.

named event rule (NER) Encapsulated, reusable business logic created using event rules, rather that C
programming. NERs are also called business function event rules. NERs can be reused
in multiple places by multiple programs. This modularity lends itself to streamlining,
reusability of code, and less work.

nota fiscal In Brazil, a legal document that must accompany all commercial transactions for tax
purposes and that must contain information required by tax regulations.

nota fiscal factura In Brazil, a nota fiscal with invoice information.

See also nota fiscal.
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Object ConfigurationManager
(OCM)

In PeopleSoft EnterpriseOne, the object request broker and control center for the
runtime environment. OCM keeps track of the runtime locations for business
functions, data, and batch applications. When one of these objects is called, OCM
directs access to it using defaults and overrides for a given environment and user.

Object Librarian A repository of all versions, applications, and business functions reusable in
building applications. Object Librarian provides check-out and check-in capabilities
for developers, and it controls the creation, modification, and use of PeopleSoft
EnterpriseOne objects. Object Librarian supports multiple environments (such as
production and development) and enables objects to be easily moved from one
environment to another.

Object Librarian merge A process that blends any modifications to the Object Librarian in a previous release
into the Object Librarian in a new release.

Open Data Access (ODA) An interoperability model that enables you to use SQL statements to extract
PeopleSoft EnterpriseOne data for summarization and report generation.

Output Stream Access (OSA) An interoperability model that enables you to set up an interface for PeopleSoft
EnterpriseOne to pass data to another software package, such as Microsoft Excel,
for processing.

package EnterpriseOne objects are installed to workstations in packages from the deployment
server. A package can be compared to a bill of material or kit that indicates the
necessary objects for that workstation and where on the deployment server the
installation program can find them. It is point-in-time snap shot of the central objects
on the deployment server.

package build A software application that facilitates the deployment of software changes and new
applications to existing users. Additionally, in PeopleSoft EnterpriseOne, a package
build can be a compiled version of the software. When you upgrade your version of the
ERP software, for example, you are said to take a package build.

Consider the following context: “Also, do not transfer business functions into the
production path code until you are ready to deploy, because a global build of business
functions done during a package build will automatically include the new functions.”
The process of creating a package build is often referred to, as it is in this example,
simply as “a package build.”

package location The directory structure location for the package and its set of replicated objects.
This is usually \\deployment server\release\path_code\package\package name. The
subdirectories under this path are where the replicated objects for the package are
placed. This is also referred to as where the package is built or stored.

PackageWorkbench An application that, during the InstallationWorkbench process, transfers the package
information tables from the Planner data source to the System-release number data
source. It also updates the Package Plan detail record to reflect completion.

PeopleSoft Database See JDEBASE Database Middleware.

planning family Ameans of grouping end items whose similarity of design and manufacture facilitates
being planned in aggregate.

preference profile The ability to define default values for specified fields for a user-defined hierarchy of
items, item groups, customers, and customer groups.

print server The interface between a printer and a network that enables network clients to connect
to the printer and send their print jobs to it. A print server can be a computer, separate
hardware device, or even hardware that resides inside of the printer itself.

pristine environment A PeopleSoft EnterpriseOne environment used to test unaltered objects with
PeopleSoft demonstration data or for training classes. You must have this environment
so that you can compare pristine objects that you modify.
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processing option A data structure that enables users to supply parameters that regulate the running of
a batch program or report. For example, you can use processing options to specify
default values for certain fields, to determine how information appears or is printed,
to specify date ranges, to supply runtime values that regulate program execution,
and so on.

production environment A PeopleSoft EnterpriseOne environment in which users operate EnterpriseOne
software.

production-grade file server A file server that has been quality assurance tested and commercialized and that is
usually provided in conjunction with user support services.

program temporary fix (PTF) A representation of changes to PeopleSoft software that your organization receives
on magnetic tapes or disks.

project In PeopleSoft EnterpriseOne, a virtual container for objects being developed in Object
Management Workbench.

promotion path The designated path for advancing objects or projects in a workflow. The following
is the normal promotion cycle (path):

11>21>26>28>38>01

In this path, 11 equals new project pending review, 21 equals programming, 26 equals
QA test/review, 28 equals QA test/review complete, 38 equals in production, 01 equals
complete. During the normal project promotion cycle, developers check objects out
of and into the development path code and then promote them to the prototype path
code. The objects are then moved to the productions path code before declaring
them complete.

proxy server A server that acts as a barrier between a workstation and the internet so that the
enterprise can ensure security, administrative control, and caching service.

published table Also called a master table, this is the central copy to be replicated to other machines.
Residing on the publisher machine, the F98DRPUB table identifies all of the published
tables and their associated publishers in the enterprise.

publisher The server that is responsible for the published table. The F98DRPUB table identifies
all of the published tables and their associated publishers in the enterprise.

pull replication One of the PeopleSoft methods for replicating data to individual workstations.
Such machines are set up as pull subscribers using PeopleSoft EnterpriseOne data
replication tools. The only time that pull subscribers are notified of changes, updates,
and deletions is when they request such information. The request is in the form of a
message that is sent, usually at startup, from the pull subscriber to the server machine
that stores the F98DRPCN table.

QBE An abbreviation for query by example. In PeopleSoft EnterpriseOne, the QBE line is
the top line on a detail area that is used for filtering data.

real-time event A service that uses system calls to capture PeopleSoft EnterpriseOne transactions as
they occur and to provide notification to third-party software, end users, and other
PeopleSoft systems that have requested notification when certain transactions occur.

refresh A function used to modify PeopleSoft EnterpriseOne software, or subset of it, such
as a table or business data, so that it functions at a new release or cumulative update
level, such as B73.2 or B73.2.1.

replication server A server that is responsible for replicating central objects to client machines.

quote order In PeopleSoft EnterpriseOne Procurement and Subcontract Management, a request
from a supplier for item and price information from which you can create a purchase
order.
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In PeopleSoft EnterpriseOne Sales Order Management, item and price information for
a customer who has not yet committed to a sales order.

selection Found on PeopleSoft menus, a selection represents functions that you can access
from a menu. To make a selection, type the associated number in the Selection field
and press Enter.

ServerWorkbench An application that, during the InstallationWorkbench process, copies the server
configuration files from the Planner data source to the System-release number data
source. It also updates the Server Plan detail record to reflect completion.

spot rate An exchange rate entered at the transaction level. This rate overrides the exchange rate
that is set up between two currencies.

Specification merge Amerge that comprises three merges: Object Librarian merge, Versions List merge,
and Central Objects merge. The merges blend customer modifications with data that
accompanies a new release.

specification A complete description of a PeopleSoft EnterpriseOne object. Each object has its own
specification, or name, which is used to build applications.

Specification Table Merge
Workbench

An application that, during the InstallationWorkbench process, runs the batch
applications that update the specification tables.

store-and-forward The mode of processing that enables users who are disconnected from a server to enter
transactions and then later connect to the server to upload those transactions.

subscriber table Table F98DRSUB, which is stored on the publisher server with the F98DRPUB table
and identifies all of the subscriber machines for each published table.

supplemental data Any type of information that is not maintained in a master file. Supplemental data is
usually additional information about employees, applicants, requisitions, and jobs
(such as an employee’s job skills, degrees, or foreign languages spoken). You can track
virtually any type of information that your organization needs.

For example, in addition to the data in the standard master tables (the Address Book
Master, Customer Master, and Supplier Master tables), you can maintain other
kinds of data in separate, generic databases. These generic databases enable a
standard approach to entering and maintaining supplemental data across PeopleSoft
EnterpriseOne systems.

table access management
(TAM)

The PeopleSoft EnterpriseOne component that handles the storage and retrieval
of use-defined data. TAM stores information, such as data dictionary definitions;
application and report specifications; event rules; table definitions; business function
input parameters and library information; and data structure definitions for running
applications, reports, and business functions.

Table ConversionWorkbench An interoperability model that enables the exchange of information between
PeopleSoft EnterpriseOne and third-party systems using non-PeopleSoft
EnterpriseOne tables.

table conversion An interoperability model that enables the exchange of information between
PeopleSoft EnterpriseOne and third-party systems using non-PeopleSoft
EnterpriseOne tables.

table event rules Logic that is attached to database triggers that runs whenever the action specified by
the trigger occurs against the table. Although PeopleSoft EnterpriseOne enables event
rules to be attached to application events, this functionality is application specific.
Table event rules provide embedded logic at the table level.

terminal server A server that enables terminals, microcomputers, and other devices to connect to a
network or host computer or to devices attached to that particular computer.
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three-tier processing The task of entering, reviewing and approving, and posting batches of transactions in
PeopleSoft EnterpriseOne.

three-way voucher match In PeopleSoft EnterpriseOne Procurement and Subcontract Management, the process
of comparing receipt information to supplier’s invoices to create vouchers. In a
three-way match, you use the receipt records to create vouchers.

transaction processing (TP)
monitor

Amonitor that controls data transfer between local and remote terminals and the
applications that originated them. TP monitors also protect data integrity in the
distributed environment and may include programs that validate data and format
terminal screens.

transaction set An electronic business transaction (electronic data interchange standard document)
made up of segments.

trigger One of several events specific to data dictionary items. You can attach logic to a data
dictionary item that the system processes automatically when the event occurs.

triggering event A specific workflow event that requires special action or has defined consequences
or resulting actions.

two-way voucher match In PeopleSoft EnterpriseOne Procurement and Subcontract Management, the process
of comparing purchase order detail lines to the suppliers’ invoices to create vouchers.
You do not record receipt information.

User Overrides merge Adds new user override records into a customer’s user override table.

variance In Capital Asset Management, the difference between revenue generated by a piece of
equipment and costs incurred by the equipment.

In EnterpriseOne Project Costing and EnterpriseOne Manufacturing Management, the
difference between two methods of costing the same item (for example, the difference
between the frozen standard cost and the current cost is an engineering variance).
Frozen standard costs come from the Cost Components table, and the current costs are
calculated using the current bill of material, routing, and overhead rates.

Version List merge The Versions List merge preserves any non-XJDE and non-ZJDE version
specifications for objects that are valid in the new release, as well as their processing
options data.

visual assist Forms that can be invoked from a control via a trigger to assist the user in determining
what data belongs in the control.

vocabulary override An alternate description for a data dictionary item that appears on a specific PeopleSoft
EnterpriseOne or World form or report.

wchar_t An internal type of a wide character. It is used for writing portable programs for
international markets.

web application server Aweb server that enables web applications to exchange data with the back-end
systems and databases used in eBusiness transactions.

web server A server that sends information as requested by a browser, using the TCP/IP set of
protocols. A web server can do more than just coordination of requests from browsers;
it can do anything a normal server can do, such as house applications or data. Any
computer can be turned into a web server by installing server software and connecting
the machine to the internet.

Windows terminal server Amultiuser server that enables terminals and minimally configured computers to
displayWindows applications even if they are not capable of runningWindows
software themselves. All client processing is performed centrally at theWindows
terminal server and only display, keystroke, and mouse commands are transmitted over
the network to the client terminal device.
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workbench A program that enables users to access a group of related programs from a single
entry point. Typically, the programs that you access from a workbench are used to
complete a large business process. For example, you use the EnterpriseOne Payroll
Cycle Workbench (P07210) to access all of the programs that the system uses to
process payroll, print payments, create payroll reports, create journal entries, and
update payroll history. Examples of PeopleSoft EnterpriseOne workbenches include
Service Management Workbench (P90CD020), Line SchedulingWorkbench (P3153),
PlanningWorkbench (P13700), Auditor’s Workbench (P09E115), and Payroll Cycle
Workbench.

work day calendar In EnterpriseOneManufacturing Management, a calendar that is used in planning
functions that consecutively lists only working days so that component and work order
scheduling can be done based on the actual number of work days available. A work
day calendar is sometimes referred to as planning calendar, manufacturing calendar, or
shop floor calendar.

workflow The automation of a business process, in whole or in part, during which documents,
information, or tasks are passed from one participant to another for action, according
to a set of procedural rules.

workgroup server A server that usually contains subsets of data replicated from a master network server.
A workgroup server does not perform application or batch processing.

XAPI events A service that uses system calls to capture PeopleSoft EnterpriseOne transactions as
they occur and then calls third-party software, end users, and other PeopleSoft systems
that have requested notification when the specified transactions occur to return a
response.

XMLCallObject An interoperability capability that enables you to call business functions.

XMLDispatch An interoperability capability that provides a single point of entry for all XML
documents coming into PeopleSoft EnterpriseOne for responses.

XMLList An interoperability capability that enables you to request and receive PeopleSoft
EnterpriseOne database information in chunks.

XML Service An interoperability capability that enables you to request events from one PeopleSoft
EnterpriseOne system and receive a response from another PeopleSoft EnterpriseOne
system.

XMLTransaction An interoperability capability that enables you to use a predefined transaction type to
send information to or request information from PeopleSoft EnterpriseOne. XML
transaction uses interface table functionality.

XMLTransaction Service
(XTS)

Transforms an XML document that is not in the PeopleSoft EnterpriseOne format into
an XML document that can be processed by PeopleSoft EnterpriseOne. XTS then
transforms the response back to the request originator XML format.

Z event A service that uses interface table functionality to capture PeopleSoft EnterpriseOne
transactions and provide notification to third-party software, end users, and other
PeopleSoft systems that have requested to be notified when certain transactions occur.

Z table Aworking table where non-PeopleSoft EnterpriseOne information can be stored and
then processed into PeopleSoft EnterpriseOne. Z tables also can be used to retrieve
PeopleSoft EnterpriseOne data. Z tables are also known as interface tables.

Z transaction Third-party data that is properly formatted in interface tables for updating to the
PeopleSoft EnterpriseOne database.
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